Cone Beam 3D + 2D Panoramic Dental Imaging System

Installation Manual
IMPORTANT! . . . X-RAY PROTECTION

X-ray equipment may cause injury if used improperly. The instructions contained in this manual must be read and followed when installing this scanner. The scanner provides a high degree of protection from unnecessary X-radiation. However, no practical design can provide complete protection, nor prevent operators from exposing themselves or others to unnecessary radiation. It is important that you become fully acquainted with applicable government radiation protection regulations. Many provisions of these regulations are based on the recommendations of the National Council on Radiation Protection and Measurements. Recommendations for dental X-ray protection are published in NCRP Report Number 35 available from NCRP Publications, 7910 Woodmont Ave., Suite 800, Bethesda, MD (USA) 20814, or at www.ncrp.com. Personal radiation monitoring and protective devices are available. You are urged to use them to protect against unnecessary X-radiation exposure.
# Table of Contents

Supplemental Components ................................................................. vii  
PAN Scan Components ........................................................................ viii  

## Chapter 1 - Scanner Assembly

*Install Scanner* ................................................................. 1-1  
*Install Retention Brackets* ................................................................. 1-11  
*Install Scanner Controller, Touch Screen and Keyboard* ......................... 1-13  
*Level Gantry* ........................................................................ 1-14  
*Check Version of SmartScan STUDIO* ................................................. 1-16  
*Set Scanner Controller Date, Time, and Time Zone* ................................ 1-16  
*Language and Locale Settings* .............................................................. 1-16  
*Change Settings of Support URLs (Optional)* ......................................... 1-17  

## Chapter 2 - Calibration and Laser Adjustments

*Panel Calibration* ........................................................................ 2-2  
*Run Panel Calibration* ..................................................................... 2-2  
*Adjust Crosshair Laser* .................................................................... 2-2  
*Patient Chair Alignment* .................................................................... 2-5  
*Install Chair Calibration Fixture* ............................................................ 2-5  
*Run Chair Calibration* ....................................................................... 2-6  
*Adjust Centerline Laser* ..................................................................... 2-7  

## Geometric Calibration

*Install Geometric Calibration Fixture* ...................................................... 2-9  
*Run Geometric Calibration* ................................................................... 2-9  
*Shutter Calibration* ........................................................................... 2-11  
*Run Shutter Calibration* ...................................................................... 2-11  
*Head Holder Alignment* ...................................................................... 2-12  

## Chapter 3 - Load Clinical Software and Configure System

*Software Installation Overview* .......................................................... 3-1  
*Site IT Network Setup* ....................................................................... 3-5  
*Network Access Permissions* ............................................................... 3-5  
*SmartScan STUDIO Manager Status Indicators* ...................................... 3-6  
*Fixed IP Addresses* ........................................................................ 3-8  
*Risk of Changes to Site Network* .......................................................... 3-9  
*Alternate Network Configurations* ......................................................... 3-10  

### Scenario 1 - i-CAT FLX Installation

*Scenario 2 - Replace Existing i-CAT 17-19 or KaVo 3D eXam with an i-CAT FLX (without DEXIS)* ......................................................... 3-12
Scenario 3 - New DEXIS - i-CAT FLX Installation ............................................. 3-13
Scenario 4 - Upgrade Existing DEXIS (without i-CAT 17-19 or KaVo 3D eXam) with DEXIS - i-CAT FLX ............................................................... 3-15
Install and Configure Clinical Software .............................................................................. 3-18
  Install SmartScan STUDIO Server Components .......................................................... 3-18
  Install SmartScan STUDIO Client Components ......................................................... 3-21
  Configure TxSTUDIO Software .................................................................................. 3-24
  Configure Patient Data Utility ................................................................................... 3-26
  Configure SmartScan STUDIO PACS Modules (Optional) ........................................ 3-26
  Configure Legacy Practice Management Interface (Optional) ................................... 3-30
  Set Up SmartScan STUDIO Twain Driver (Optional) ............................................... 3-32
Installation Check ............................................................................................................ 3-33
  Installation Check for i-CAT FLX Installation ............................................................ 3-33
  Installation Check for a DEXIS i-CAT FLX Installation ........................................... 3-33

Chapter 4 - QA Tests

Run QA Tests .................................................................................................................. 4-1
QA Line Pair Test ........................................................................................................... 4-1
  Set Up QA Phantom ................................................................................................ 4-1
  Run QA Line Pair Test ......................................................................................... 4-2
  QA Line Pair Evaluation ....................................................................................... 4-3
QA Material Test ......................................................................................................... 4-3
  Set Up QA Phantom ............................................................................................ 4-3
  Run QA Material Test ......................................................................................... 4-3
  QA Material Evaluation ....................................................................................... 4-4
QA Air Water Test ........................................................................................................ 4-4
  Set Up QA Air Water Phantom ........................................................................... 4-4
  Run QA Air Water Test ....................................................................................... 4-5
  QA Air Water Test Evaluation ............................................................................ 4-5
QA PAN Test ................................................................................................................. 4-6
  Install PAN Phantom ............................................................................................ 4-6
  Run QA PAN Test .............................................................................................. 4-7
  QA PAN Test Evaluation ................................................................................... 4-7
Safety Checks (Optional) ............................................................................................... 4-7

Chapter 5 - Complete Installation Forms

Appendix A - Service Menu Options

Scanner Startup ............................................................................................................ A-1
  Power Up ............................................................................................................ A-1
  Log in .................................................................................................................. A-1
Run Utilities ................................................................................................................. A-2
Scanner Shutdown ...................................................................................................... A-2
  Log out ............................................................................................................ A-2
  Power Off ........................................................................................................ A-2
Table of Contents

Appendix B - Setup of Alternative Network Configurations
   Remote Image Root Setup for Domain Environment ......................... B-1
   Remote Network Share Using Windows Workgroup Environment .......... B-6

Appendix C - Wall Mounting Operator Control Box
   Wall Mount with Cable Exposed ...................................................... C-1
   Wall Mount with Cable Inside Wall ................................................ C-4
### Supplemental Components

<table>
<thead>
<tr>
<th>Component</th>
<th>Part #</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patient E-stop</td>
<td>1.005.8627</td>
<td>1</td>
</tr>
<tr>
<td>Carbon Fiber Head Rest</td>
<td>1.005.8620</td>
<td>1</td>
</tr>
<tr>
<td>Glide</td>
<td>1.006.6827</td>
<td>4</td>
</tr>
<tr>
<td>Head Restraint Band</td>
<td>1.006.3389</td>
<td>50</td>
</tr>
<tr>
<td>Tool Kit</td>
<td>1.007.1567</td>
<td>1</td>
</tr>
<tr>
<td>Velcro Head Restraint Kit</td>
<td>1.006.6829</td>
<td>1</td>
</tr>
<tr>
<td>Booster Seat</td>
<td>1.006.6830</td>
<td>1</td>
</tr>
<tr>
<td>Foot Stool</td>
<td>1.006.6857</td>
<td>1</td>
</tr>
<tr>
<td>Chin Cup</td>
<td>1.005.8616</td>
<td>1</td>
</tr>
<tr>
<td>Foam Disk</td>
<td>1.007.1509</td>
<td>1</td>
</tr>
<tr>
<td>Cable Guides</td>
<td>1.006.6833</td>
<td>6</td>
</tr>
<tr>
<td>Platform Assembly</td>
<td>1.006.6834</td>
<td>1</td>
</tr>
<tr>
<td>Chair Calibration Fixture</td>
<td>1.007.1394</td>
<td>1</td>
</tr>
<tr>
<td>Handswitch (optional)</td>
<td>1.010.3959</td>
<td>1</td>
</tr>
</tbody>
</table>

Available on request
### PAN Scan Components

<table>
<thead>
<tr>
<th>Component</th>
<th>Part #</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cord Retention Bracket</td>
<td>1.012.6471</td>
<td>1</td>
</tr>
<tr>
<td>GeoCal Fixture</td>
<td>1.006.5150</td>
<td>1</td>
</tr>
<tr>
<td>Water Jar Phantom</td>
<td>1.006.5152</td>
<td>1</td>
</tr>
<tr>
<td>Overhead Cord Bracket</td>
<td>1.012.5468</td>
<td>1</td>
</tr>
<tr>
<td>QA Phantom</td>
<td>1.006.6831</td>
<td>1</td>
</tr>
<tr>
<td>Chin Rest Slide, Straight</td>
<td>1.006.6840</td>
<td>1</td>
</tr>
<tr>
<td>Bite Tip Holder</td>
<td>1.007.0552</td>
<td>2</td>
</tr>
<tr>
<td>Position Alignment Tool</td>
<td>1.007.0551</td>
<td>1</td>
</tr>
<tr>
<td>PAN Head Holder</td>
<td>1.006.9828</td>
<td>1</td>
</tr>
<tr>
<td>Pan Phantom</td>
<td>1.006.6828</td>
<td>1</td>
</tr>
<tr>
<td>Bite Tip</td>
<td>1.006.9826</td>
<td>25</td>
</tr>
<tr>
<td>Chin Rest</td>
<td>1.006.9827</td>
<td>1</td>
</tr>
</tbody>
</table>
Chapter 1  Scanner Assembly

NOTE: Do NOT begin installation of any equipment or software unless the Preinstall Checklist (ISI-MKTG-CS-0007) has been completed for the site.

Install Scanner

There are two methods used for shipping the scanner, assembled and non-assembled. Start with step one for the non-assembled scanner. Start with step 13 for scanners that are shipped assembled. Before moving the scanner into place, ensure that the area is clean and that there is ample room to work.

WARNING

This scanner has assemblies that require a two person lift. Failure to comply may cause bodily injury. Two adults are required to unpack and assemble this scanner.

CAUTION

Follow instructions on all shipping labels to ensure proper handling of the scanner. For scanners that are shipped assembled, the chair column must be removed from the scanner before moving scanner into place. Remove four screws at rear of chair column to remove column. Moving scanner with the chair column attached may cause damage to the equipment.

1. With the help of an assistant, install the lower plate under the two leg assemblies, as shown.

2. Attach with mounting hardware, four SHCS 1/4-20 x 5 long with 1/4” split washers, both sides.
3. Remove both top covers (six mounting screws).

WARNING
This scanner requires a two person lift. Failure to comply may cause bodily injury. Two adults are required to assemble this scanner.

CAUTION
Use extreme care not to scratch overhead assembly when mounting scanner onto leg assemblies.

4. With an assistant, lift overhead into place on top of leg assemblies.

5. Ensure the pins on rear of the overhead are seated into the holes on leg assemblies.
6. When seated properly, overhead locks into place. To ensure safety, the overhead should still be supported by an assistant until mounted.

7. From rear of scanner, secure overhead with mounting hardware, two SHCS 1/4-20 x 5/8 long with 1/4” split washers, both sides.

8. The scanner must be checked for squareness prior to installing the mounting hardware at the top of the overhead.

9. Hook a tape-measure on bottom rear edge of scanner, as shown.

10. Run the tape diagonally to the upper open corner, as shown and record the measurement.

   Measurement should be approximately 65-3/8” [166cm].

11. Take the same measurement on the opposite corners and record measurement.

   The two measurements must be identical ± 1/16” [1.6mm].

   If measurements are not within tolerance, push the top of the scanner to the right or left and remeasure.
12. From top of scanner, secure overhead with mounting hardware, two SHCS 1/4-20 x 5/8 long with 1/4" split washers, both sides.

⚠️ CAUTION ⚠️
Care must be taken when sliding the scanner into place. To prevent the scanner from scratching the floor surface, place the four glides under the scanner feet.

13. With the help of an assistant, tilt the scanner to install the glides under the four feet (corners of scanner).
14. Slide the scanner into place and remove the glides.

15. Position patient chair on base. Ensure base frame centering screw is seated within patient chair centering block.
16. Loosely secure patient chair to base. **Do not tighten.**
17. Remove four long screws from red shipping plate. Keep shipping plate attached with remaining hardware. Do NOT discard mounting hardware. Long screws used for receptor assembly mounting and short screws for source assembly.

**WARNING**
The receptor assembly requires a two person lift. Failure to comply may cause bodily injury.

18. Locate receptor assembly and remove packing material.
19. Remove rear receptor assembly cover (2 screws).

20. With an assistant, mount the receptor assembly by aligning the mounting pins.
21. Attach assembly with four long mounting screws acquired from red shipping plate. Once secured, remove remaining screws from shipping plate and save for later use. Remove shipping plate.
22. Feed cabling through receptor assembly (6 wires).
**CAUTION**

When mating connectors, do not force-fit connectors together. All connectors are color coded and keyed to prevent improper mating.

23. Feed gray wire with red/white connector through brackets and connect to other red/white connector.

24. Feed second gray wire through brackets and connect the red/black wires with white connectors.

25. Connect together the green/yellow ground wires.

26. Feed grey wire with green connector through brackets and connect to motor assembly.
27. Unlatch panel cover by pulling cover forward slightly, then swinging cover outward to remove.

28. Feed LEMO connector through hub and plug into panel. Rotate red dot on connector to the 3 o’clock position. Slide connector into receptor until it snaps in place.

29. Feed green network connector through the hub and plug connector into panel.

30. Snap panel cover into place. Receptor assembly cover can remain off for GeoCal adjustments.

31. Locate X-ray source assembly and remove from packing material.

32. Place assembly on clean surface. Remove and set aside the magnetic mounted X-Ray source window panel from the cover.

33. Remove cover mounting screws from top and bottom of scanner (quantity 4 outer cover and 4 inner source cover).

34. Detach outer cover ONLY.
35. Carefully detach and move inner source cover a few inches away from assembly.
36. Remove ribbon cable from beam limiter assembly by pressing connector locking tab.

37. Using very little force, slowly rotate gantry, counterclockwise. Stop the rotation when you feel that the gantry is at the limit switch position.
38. Slide inner source cover onto the gantry overhead.

**WARNING**

The X-ray source assembly requires a two person lift. Failure to comply may cause bodily injury.
39. With an assistant, align X-ray source assembly mounting pins.

40. Attach assembly using the four mounting screws previously removed from red shipping plate along with four split washers.

41. Draw the 3 cables out through the opening. Ensure that the cables are not stretched or damaged.
   • black cable (2 connectors)
   • grey cable (single connector)
   • green ground cable (ground lug)

42. Record label information that is required on Installation Sheet (Serial Number, etc.).

⚠️ CAUTION

When mating connectors, do not force-fit together.

43. Attach ground lug by removing mounting nut and installing lug over the star-lock washer. Replace mounting nut.

44. Attach together, black cables with the two connectors.

45. Attach grey wire with red/white connector as shown. Ensure red side of connector is facing upward.

46. Attach ribbon cable back to the beam limiter assembly.
47. Slide inner source cover into place, onto top mounting notches.
48. Mount outer cover onto mounting notches, over panel cover.
49. Attach covers with hex mounting screws at top and bottom (quantity 4 outer cover and 4 inner source cover).

50. Connect chair control cable to 1520 (Chair) connector on rear of overhead panel.
51. Connect control box cable to 1518 (Control Box) connector on rear of overhead panel. Connectors are keyed to prevent improper insertion.

   For wall mounting options, see Wall Mount Control Box chapter.
52. Connect shorting plug to 1525 (door interlock) on rear of overhead panel.
53. Connect Ethernet cable for scanner controller to rear of overhead panel.

54. Connect chair control cable to patient chair connector.
55. Connect patient emergency stop control to patient chair connector. Connectors are keyed to prevent improper insertion. Rotate red emergency stop button to verify that it is disengaged.
56. Connect power cable to **AC POWER IN** connector on rear of overhead panel.
57. Ensure the power circuit breaker on the overhead rear panel is set to the **0** (off) position.

58. To ensure that the device cabling does not interfere with the rotation of the gantry, use cable guides to dress cabling as shown.

---

**Install Retention Brackets**

Permanently connect the line cord to the scanner and wall receptacle using retention brackets provided.

**Install Overhead Cord Bracket at Scanner Input**

1. Remove two screws and washers next to scanner line cord input. Retain hardware.

2. Install overhead cord bracket over line cord, and align holes of bracket to holes in rear overhead.

3. Install bracket with two screws and washers, securing line cord in place.

**Install Line Cord Retention Bracket at Wall Receptacle**

⚠️ **CAUTION**

Power to the wall receptacle should be turned off during this procedure. Connect to hospital grade power only.
1. Determine proper bracket set configuration to use based on outlet receptacle and wall plug that will be used. See figure and use configuration A or B.

2. Plug scanner line cord into wall receptacle.

3. For configuration A, loosen hardware holding bracket set together so that brackets can slide freely for positioning.

   For configuration B, remove hardware holding bracket set together. Flip the position of the bracket that will rest on the face of the plug, then loosely secure brackets together with hardware.

4. Position bracket set in intended location over line cord and mark the relative position of the brackets to each other with a pencil.

5. In a work area, align the mark on the brackets, and tighten hardware.

6. Position assembled bracket set over line cord, and mark the wall with the location of the two holes needed to mount the bracket set.

7. Put bracket set aside and drill mounting holes.

   **NOTE:** Use wall anchors/screws or appropriate mounting hardware to mount the bracket set to the wall. The type and length of mounting hardware used must be suitable for the wall to which the bracket set is fixed. The installer is responsible for obtaining the proper mounting hardware.

8. Install appropriate mounting hardware to mount the bracket set to the wall, trapping the line cord in place.
Install Scanner Controller, Touch Screen and Keyboard

1. Place scanner controller, touch screen and keyboard in position.

2. Connect power cables for scanner controller and for touch screen to each device and to power strip. For scanner controller and touch screen, use a power strip that is rated at a minimum of 2350 joules.

3. Connect the following to back of scanner controller:
   - Local Area Network (LAN)
   - Keyboard (USB)
   - Scanner - ACQ Computer Cable (Ethernet)
   - Touch screen - USB and cable (connect with VGA-to-DVI adapter)

4. Set power switch at rear of scanner controller to 1 (on). This does NOT power on the device. Peripheral devices will be powered on later in the workflow.

⚠️ CAUTION
To assure proper Ethernet communications (1 GB) between the scanner controller and the scanner, connect the Ethernet cable from the scanner controller directly to the scanner. Do not connect the Ethernet cable from the scanner controller to the scanner through the use of wall plates, or any other intermediate connection. Use only CAT 5e cable (supplied) or better.
Level Gantry

To achieve optimal performance, it is imperative that the gantry be properly leveled.

1. Scanner must be leveled from side-to-side and front-to-back.

2. To level Overhead Gear, adjust the front gantry feet from the top, using a 1/4" nut driver. Have a second person tilt the scanner enough to minimize the load on the feet while turning.

   If the scanner does not have top access holes, tilt scanner and adjust the feet from underneath by rotating the large base of each foot.

   ! CAUTION

   Never use the gate for tilting or moving the scanner, as this may cause permanent damage to the scanner.

3. Adjust the rear gantry feet using the 1/2" open-ended wrench.

   NOTE: Ensure levelness of overhead gear is measured front-to-back and side-to-side.
4. Store red shipping bracket in overhead.

5. Replace shielding cover.

6. Replace top cover (6 screws).

7. Install mounting bar on wall, centered behind the scanner. The height should be approximately 66 ½ to 68 inches [169 to 173 cm] from the floor to the center of the mounting bar. However, this may vary, so you may want to put the “L” brackets on scanner and mark the wall to verify the height.

8. Use 3 wall anchors/screws to mount the bar securely to the wall. The type and length of mounting hardware must be suitable for the wall to which the unit is fixed. The installer is responsible for obtaining the proper mounting hardware.

9. Attach brackets to the scanner and mounting bar.

10. Switch the power circuit breaker located on the overhead rear panel to I (on).
11. Press the control box ON button. The scanner is now powered.

12. Power on the scanner controller (power button in front) and touch screen (power button on right side).

**NOTE:** If at any time the Ethernet cable connecting the scanner to the scanner controller becomes disconnected, reconnect the cable and cycle the power to the scanner from the circuit breaker at the rear of the scanner overhead.

**Check Version of SmartScan STUDIO**

1. At the touch screen, press ? on the log in screen.

2. Check the version of SmartScan STUDIO™. Call Technical Support to ask about later versions of the software that are available.

**NOTE:** If v2.7 or higher is installed, a unique software license is required to establish the accessible field of view for the scanner. A license file is installed at the factory, but in some cases, the purchased field of view size may not have been known at that time. Log in, select **Acquire** from the menu, and navigate to the Protocol screen. If the protocols displayed are not correct for the field of view purchased, for example, V8 protocols display instead of V17 protocols, contact Technical Support to obtain an updated license file. Refer to the **i-CAT FLX User Manual** for a list of the protocols for each field of view type.

**Set Scanner Controller Date, Time, and Time Zone**

**NOTE:** See **Service Menu Options** chapter for instructions on logging in to the scanner controller.

1. Log in to the scanner controller.

2. Select **Date and Time**.

3. Select **Change date and time**... and set to the current local date and time. Press **OK**.

4. Select **Change time zone**... and select the local time zone from the drop-down menu. Press **OK**.

**Language and Locale Settings**

Language and locale settings for the scanner controller can be changed from the Configurator. Select the **Regional** option. Languages currently supported by SmartScan STUDIO are on the drop-down list. You will be prompted to reboot the scanner controller if you change the language. US English is the default language.
Language and locale settings for the server and client workstations are determined by the operating system settings (Windows Control Panel, Region and Language settings). If the selected language is supported by SmartScan STUDIO, the user interfaces are displayed in the selected language.

**Change Settings of Support URLs (Optional)**

The SmartScan STUDIO menu has two options that access external webpage URLs:

- Technical Support
- Remote Assistance

The webpage URLs may need to be changed depending on the region of the world where the scanner is being installed. The default settings are for the United States.

1. Log in to the scanner controller and select **Set Support URLs** from the menu.
2. Select an option and press **Enter**. Follow prompts to make selections.

**Specific Country Options** - Select the correct option to re-set default options for the United States (1) that are pre-loaded, or set the default options for Australia (2). See example below.

![Command prompt window showing options for setting support URLs](image.png)
**Custom Option** - Select this option to enter custom URLs for remote assistance and technical support options. See example below.

3. After entering changes, you must logout for the changes to take effect.

4. Log in and select the **Technical Support** and **Remote Assistance** options to check that the URLs are set correctly.
Chapter 2  Calibration and Laser Adjustments

Calibrations are accessed from the Utilities menu in SmartScan STUDIO. See Service Menu Options chapter for instructions on logging in and accessing Utilities.

**NOTE:** Ensure scanner is mounted to the wall before beginning calibrations. This should have been completed during the Level Gantry procedure.

Calibrations and adjustments should be performed in the following order:

1. Panel Calibration
2. Crosshair Laser Adjustment
3. Chair Calibration
4. Centerline Laser Adjustment
5. Geometric Calibration (run with cover off for adjustments, re-run with cover installed)
6. Shutter Calibration
7. Head Holder Alignment

**NOTE:** The panel cover fits very tightly over the receptor panel. If the panel cover is removed and re-installed for any reason, perform items 2 - 5.

---

**CAUTION**

If the optional deadman handswitch is installed on the scanner, press and hold handswitch before pressing the **Scan** button, and continue to hold handswitch down for the duration of the exposure (**X-ray** light on). Early release of the handswitch stops the exposure and the **Fault** light turns on. The patient will have to be re-scanned.
Panel Calibration

The Panel Cal is performed in landscape and portrait (V17 systems only) positions for 4 x 4 and 2 x 2 resolutions. Several tests run as part of the panel calibration. A pie chart displays status.

Run Panel Calibration

1. From Utilities menu, select PanelCal.
2. Ensure the field of view on the scanner is clear.
4. When prompted, press the Scan button on the operator control box. An audible alarm is sounded and the X-ray ON light is illuminated during radiation exposure.
5. You will be prompted to press the Scan button for each test.
   **NOTE:** The panel will rotate to the portrait position at the start of the portrait tests (V17 systems only).
6. When Panel Cal is complete, Calibration Complete is displayed.
7. Press to display Complete screen and select option to go Back to Utility.

Adjust Crosshair Laser

**WARNING**

Do not stare into laser. Severe personal injury (blindness) may result.

When the ALIGNMENT LIGHT button is pressed, the crosshair laser shines from the X-ray source panel and appears on the receptor panel. The crosshairs should appear directly in line with the four notches on the panel cover, as shown below.

There are three types of laser adjustments:

- Horizontal Line up/down
- Vertical Line forward/backward
- Rotate Crosshairs
**CAUTION**

Ensure that the cover is positioned so that the side notches are toward the bottom of the panel.

1. Remove beam limiter cover to gain access to the crosshair laser. The cover is attached magnetically.

**Horizontal Line Adjustment:**

2. Check height of horizontal crosshair line with panel cover notches.
3. To move horizontal laser line up/down, turn adjustment screw (shown):
   • Clockwise - moves line up
   • Counter-clockwise - moves line down

Vertical Line Adjustment:

4. Check position of vertical crosshair line with panel cover notches.

5. To move vertical laser line forward/backward, loosen the two mounting screws (shown). The bracket pivots on the center mounting screw which moves the vertical laser line.

6. Tighten both screws when properly aligned.
Rotate Crosshair Laser Lines:

7. Check crosshair lines with panel cover notches to see if a rotation adjustment is required.

8. To rotate laser crosshairs slightly loosen the two laser mounting screws (shown).

9. To help rotate the laser, insert an allen wrench (3/32) into the top hole of the laser.

10. Tighten both screws when properly aligned and remove 3/32 allen wrench.

11. Replace beam limiter cover.

Patient Chair Alignment

Install Chair Calibration Fixture

1. Insert chair calibration fixture into positioning block.

2. Using the Alignment Light, check position of the horizontal and vertical lasers relative to the notches on the chair calibration fixture, as shown.

   • If horizontal laser is out of position, move chair calibration fixture up or down in the positioning block, and pull back on the fixture if needed to roughly align with horizontal notch. Tighten knob.
• If the Vertical Laser is out of position, adjust the chair foot from the top, using a 1/4 inch nut driver. Have a second person tilt the scanner enough to minimize the load on the foot while turning.

If the scanner does not have a top access hole, tilt scanner and adjust the foot from underneath by rotating the large base of the foot.

⚠️ CAUTION
Never use the gate for tilting or moving the scanner, as this may cause permanent damage to the scanner.

• Turn nut driver clockwise - moves calibration fixture towards rear of scanner.
• Turn nut driver counter-clockwise - moves calibration fixture toward front of scanner.

Run Chair Calibration

The chair calibration is accessed from the Utilities menu in SmartScan STUDIO.

1. From the Utilities menu, select ChairCal.

Leveling Patient Chair:

2. Ensure chair calibration fixture is properly aligned, then select 0°. Press .

3. When prompted, press Scan button on control box. An audible alarm is sounded and the X-ray ON light is illuminated during radiation exposure.

4. Review the scout image.

5. Verify that the vertical pin falls within the double lines. If aligned, press and go to step 8.

6. If not aligned, adjust the chair foot.
   
   **NOTE:** Typically, to move the pin left, turn the chair foot clockwise. To move the pin right, turn the chair foot counterclockwise.

7. Perform another scout. Repeat steps 2-6 as needed until pin falls within the double lines.
   
   Use as needed to page through scout scans to help with adjustment.
Centering Patient Chair:

8. Select 90° and press .

9. When prompted, press Scan button on control box. An audible alarm is sounded and the X-ray ON light is illuminated during radiation exposure.

10. Review the scout image.

11. Verify that the vertical pin falls within the double lines. If aligned, go to step 14.

12. If the pin is not within the double lines:

   a. Loosen 4 screws in rear of scanner.

   b. Move chair left or right by pushing on side of chair. Alternately, insert screwdriver in rear slot of scanner and pry tool left or right depending on adjustment needed.

   **NOTE:** Typically, to move the pin left, move chair assembly right (when facing front of scanner). To move the pin right, move chair assembly left (when facing front of scanner).

13. Repeat steps 8-12 as needed until pin is within the double lines on scout scan.

   Use as needed to page through scout scans to help with adjustment.

14. When pin falls within the double lines at both 0° and 90°, tighten chair mounting screws.

15. After chair assembly mounting screws are tightened, repeat ChairCal at 0° and 90° to verify chair alignment.

16. If the vertical pin falls outside the double lines at either position, repeat the necessary steps to adjust the chair, and perform a scout, until chair alignment is verified.

**Adjust Centerline Laser**

**WARNING**

Do not stare into laser. Severe personal injury (blindness) may result.

**NOTE:** Ensure that the patient chair alignment has been completed before beginning this procedure.
There are three laser adjustments:

• Right-to Left
• Angle
• Laser Line Sharpness

Right-to-Left Adjustment:

1. Loosen laser assembly set screw which allows the assembly to rotate.
2. Press the ALIGNMENT LIGHT button. The laser lights for approximately two minutes.
3. While the laser is lit, manually rotate the laser assembly until it is aligned with the center line on the chair calibration fixture.
4. While holding the assembly in place, firmly tighten set screw.
Angle Adjustment:
1. Loosen laser pointer set screw.
2. Press the ALIGNMENT LIGHT button.
3. While the laser is lit, manually rotate the laser pointer until it is aligned with the center line on the chair calibration fixture.
4. While holding the laser pointer in place, firmly tighten set screw.

Laser Line Sharpness Adjustment:
1. Loosen laser pointer lens set screw.
2. Press the ALIGNMENT LIGHT button.
3. Manually rotate laser pointer lens with your finger tip until laser line is thin and sharp. Rotating the lens for sharpness will require realignment (side-to-side and/or angle).
4. Tighten set screw to lock lens in place.

Geometric Calibration
GeoCal runs in both portrait and landscape positions. A pie chart displays status.

Install Geometric Calibration Fixture
1. Mount the phantom platform and center the GeoCal fixture on the platform using the alignment holes.
2. Ensure that the GeoCal fixture is level.
3. Using the Alignment Lasers, align the GeoCal fixture crosshair slits with the laser cross beams. The laser beams should roughly align with the fixture crosshair slits.

Run Geometric Calibration
1. From Utilities menu, select GeoCal.
2. Verify GeoCal fixture installation, then press . The scanner initializes.
3. When prompted, press the Scan button on the operator control box. An audible alarm is sounded and the X-ray ON light is illuminated during radiation exposure.
4. If the landscape calibration passes, the message Step 1 Complete is displayed. Go to step 6 to run GeoCal in portrait position.
5. If the Geometric Calibration Processing Failure message is displayed, the detector pivot is out range. The error message displays the allowed value (+/-0.050 degrees) and the actual value. To adjust detector pivot in landscape position:
a. If receptor cover is installed, remove both mounting screws (3/32") from the bottom and remove cover from mounting tabs, which are located at the top.

b. On the receptor assembly, loosen the 5/32” set screw.

c. The 1/4” adjustment screw is used to adjust the detector pivot.

Turning the adjustment screw one full turn is an adjustment of 0.3.

Typically, turn screw counter-clockwise to subtract from the displayed number and clockwise to add to the displayed number (facing the screw).

d. A hex shape consists of six flat sides. Measure the turns by hex flats which equal 0.05 per flat. Six flats equal 0.3.

e. Tighten the 5/32” set screw after the adjustment is made.

f. In GeoCal, press OK to rerun in landscape position. Repeat as needed until landscape calibration passes.

6. Press to initiate portrait calibration. The panel rotates.

7. When prompted, press the Scan button on the operator control box. An audible alarm is sounded and the X-ray ON light is illuminated during radiation exposure.

8. If the portrait calibration passes, the message Step 2 Complete is displayed. Go to step 10.

9. If the Geometric Calibration Processing Failure message is displayed, the detector pivot is out of range. The error message displays the allowed value (+/-0.050 degrees) and the actual value. To adjust detector pivot in portrait position:
a. On the receptor assembly, loosen the 5/32” set screw.

b. The 1/4” adjustment screw is used to adjust the detector pivot.

Turning the adjustment screw one full turn is an adjustment of 0.3.

Typically, turn screw **counter-clockwise** to **add** to the displayed number and **clockwise** to **subtract** from the displayed number (facing the screw).

c. A hex shape consists of 6 flat sides. Measure the turns by hex flats which equal 0.05 per flat. Six flats equal 0.3.

d. Tighten the 5/32” set screw after the adjustment is made.

e. In GeoCal, press **OK** to rerun in portrait position. Repeat as needed until portrait calibration passes.

10. Press ➡️ to display Complete screen.

11. Install receptor cover. Ensure mounting tabs are seated in top of cover.

12. Attach mounting screws.


14. Remove the GeoCal fixture.

**NOTE:** If a grinding noise is evident when the panel rotates between landscape and portrait positions, contact Technical Support.

**Shutter Calibration**

The Shutter Cal runs several tests in landscape and portrait (V17 systems only) positions. A pie chart displays status.

**Run Shutter Calibration**

1. From Utilities menu, select **ShutterCal**.

2. Ensure the field of view on the scanner is clear.

4. When prompted, press the Scan button on the operator control box. An audible alarm is sounded and the X-ray ON light is illuminated during radiation exposure.

5. You will be prompted to press the Scan button for each test.

   **NOTE:** The panel will rotate to the portrait position at the start of the portrait tests (V17 systems only).

6. When Shutter Cal is complete, Calibration Complete is displayed. Thumbnail images of each Shutter Cal test are available to view.

   **NOTE:** If Shutter Cal fails, re-run Panel Cal, then re-run Shutter Cal, if prompted. Otherwise, check that the field of view is clear of all objects and that there are no obstacles to the rotation of the gantry. Re-run Shutter Cal.

7. If desired, select a thumbnail to view.

8. Press \[→\] to display Complete screen and select option to go Back to Utility.

### Head Holder Alignment

**NOTE:** Ensure that the Laser Alignments have been completed before beginning this procedure.

1. If head support is installed, loosen locking knob and remove head support.

2. Slide head holder into place.

3. Place the Position Alignment tool between the temple pads with the alignment mark facing front.

4. Press the ALIGNMENT LIGHT button.

5. Loosen screws underneath head holder with allen wrench (5/32) and adjust the head holder so that the laser aligns with the alignment mark.

6. When aligned, re-tighten screws.

7. Press the Push To Release lever to open arms and remove the Position Alignment tool. Do not manually force arms open.

   **NOTE:** Remove head holder and re-install head support.
Chapter
3 Load Clinical Software and Configure System

Software Installation Overview

Four possible installation scenarios are described in this chapter:

1. New i-CAT FLX Installation (without DEXIS™)
2. Replace Existing i-CAT 17-19 or KaVo 3D eXam with i-CAT FLX (without DEXIS)
3. New DEXIS - i-CAT FLX Installation
4. Upgrade Existing DEXIS (without i-CAT 17-19 or KaVo 3D eXam) with DEXIS - i-CAT FLX

NOTE: DEXIS is optional software and is not available in all countries.

Each scenario requires a different set of software to be loaded and a different installation sequence. These are described in detail later in this chapter.

Sites can have varied hardware configurations. At a minimum, there must be one server, in addition to the i-CAT FLX scanner controller, that can serve as the long-term data storage device and as a client workstation. Most sites will have multiple workstations, where one server stores long-term data and one or more clients are attached to the server.

All servers and client workstations must be running one of the following:

- Windows® 7 Pro, Ultimate, and Enterprise (64-bit) SP1
- Windows® 8.1 Pro and Enterprise (64-bit)
- Windows® 10 Pro and Enterprise (64-bit)
- Windows® Server 2008 R2 SP1
- Windows® Server 2012 (all versions)
- Windows® Server 2012 R2 (all versions)
- Windows® Server 2016 (all versions)

The i-CAT FLX is shipped with the following:

- SmartScan STUDIO Restorative Media - used for recovery of SmartScan STUDIO software, which comes pre-installed on the scanner controller. This media should be left at the site, but is not part of this software installation.
- Imagers DVD - contains information specific to the receptor panel, and is only used to restore the panel. This DVD should be left at the site, but is not part of this software installation.
- SmartScan STUDIO Server Installation Media - required for all installation scenarios. Contains the following components:
  - SmartScan STUDIO Integration Services
  - PACS Storage Services
  - Legacy Practice Management Interface
• Data Utility (for DEXIS 10 or DEXIS 11)
• DEXIS i-CAT FLX Server Plugin (for DEXIS 10 or DEXIS 11)
• SmartScan STUDIO Client Installation Media - required for all installation scenarios.
  Contains the following components:
  • SmartScan STUDIO Manager
  • PACS QR
  • PACS MWL
  • Legacy Practice Management Viewer Launcher
  • DEXIS i-CAT FLX Client
  • Patient Data Utility
  • SmartScan STUDIO Twain Driver (32-bit)

**NOTE:** The DEXIS i-CAT FLX Client supports the following operating systems:
• Windows® 7 Professional, Ultimate, and Enterprise (64-bit and 32-bit) SP1
• Windows® 8.1 (64-bit and 32-bit)
• Windows® 10 (64-bit and 32-bit)
• Windows® Server 2008 R2 SP1
• Windows® Server 2012
• Windows® Server 2012 R2
• Windows® Server 2016

The following viewers are supported:
• TxSTUDIO™ 5.3.3 or greater
• Dolphin viewer 11.5 or greater
• OnDemand3D App and OnDemand3D Dental (64-bit and 32-bit) 2.0.10 or greater

**NOTE:** If both OnDemand3D App and OnDemand3D Dental are loaded on a workstation, SmartScan STUDIO will launch OnDemand3D App.

The following media is required for new DEXIS installations or for upgrades to existing DEXIS sites:

For DEXIS Imaging Suite 10: The
• DEXIS Imaging Suite 10 (contains a server and a client component)

For DEXIS Eleven:
• DEXIS Core
• DEXIS Eleven

**NOTE:** You may need to have Admin privileges to load software on site-provided computers.
The following diagrams show the possible installation topologies for both an i-CAT FLX installation and a DEXIS installation. Refer to Appendix B for additional network setup options.

**i-CAT FLX Installation**

**Shared Server - Client**

- Scanner Controller with software pre-installed
- Site-provided Server with Server and Client running on same machine
  - SmartScan STUDIO Integration Services
  - SmartScan STUDIO Manager
  - Viewer

**Separate Server and Client(s)**

- Scanner Controller with software pre-installed
- Site-provided Server (Separate Server)
  - SmartScan STUDIO Integration Services
  - SmartScan STUDIO Manager
  - Viewer
- Site-provided Client(s) (Separate Clients)

**Replace Existing i-CAT 17-19 or KaVo 3D eXam with an i-CAT FLX (without DEXIS)**

- Use either topology above.
- Move existing ImageRoot to site-provided server.
DEXIS - i-CAT FLX Installation (New or Existing)

Shared Server - Client

Scanner Controller with software pre-installed

Site-provided Server with Server and Client running on same machine

Separate Server and Client(s)

Scanner Controller with software pre-installed

Site-provided Server (Separate Server)

Site-provided Client(s) (Separate Clients)

* DEXIS Server or Core software may be installed on a separate server
Site IT Network Setup

⚠️ CAUTION

The scanner controller, should at no time, have Windows Log-in or Domain Log-in enabled or changes made to it. The addition of the scanner controller to a domain will render it unusable and a replacement may be required.

Network Access Permissions

In all installation cases, regardless of the topology selected, the required network permissions must be satisfied by the site’s IT department. The following table identifies the necessary access permissions for SmartScan STUDIO software components to function correctly. “Web Access” refers to providing the IP address and firewall configuration settings necessary to allow access to a component. The “Common Symptoms” column lists symptoms that occur when the corresponding access/permissions are not provided for the component.

<table>
<thead>
<tr>
<th>Software Component</th>
<th>Software Component Installation Media</th>
<th>Access/Permissions Required</th>
<th>Common Symptoms</th>
</tr>
</thead>
<tbody>
<tr>
<td>SmartScan STUDIO Integration Services</td>
<td>SmartScan STUDIO Integration Services</td>
<td>Web access to scanner controller</td>
<td>Assets not “committed”</td>
</tr>
<tr>
<td>Import Service</td>
<td>SmartScan STUDIO Server</td>
<td>Read/write access to ImageRoot folder</td>
<td>“Committed” images do not appear in ImageRoot folder</td>
</tr>
<tr>
<td>DEXIS i-CAT FLX Server Plugin</td>
<td>SmartScan STUDIO Server</td>
<td>Read/write access to DEXIS Server or Core</td>
<td>ImageRoot contains thumbnails, but DEXIS Server or Core does not</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Thumbnail does not appear in DEXIS viewer</td>
</tr>
<tr>
<td>SmartScan STUDIO Integration Services</td>
<td>SmartScan STUDIO Integration Services</td>
<td>Read/write access to ImageRoot folder</td>
<td>Exam not “Ready to View?” in exam list</td>
</tr>
<tr>
<td>Update Service</td>
<td>SmartScan STUDIO Server</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SmartScan STUDIO Integration Services</td>
<td>SmartScan STUDIO Server</td>
<td>Read access to ImageRoot folder</td>
<td>SmartScan STUDIO Manager exam list not updating</td>
</tr>
<tr>
<td>Web Service</td>
<td>SmartScan STUDIO Server</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SmartScan STUDIO Manager</td>
<td>SmartScan STUDIO Manager</td>
<td>Web access to scanner controller</td>
<td>No response from device when creating an exam</td>
</tr>
<tr>
<td></td>
<td>SmartScan STUDIO Client</td>
<td>Web access to SmartScan STUDIO Integration Services web service</td>
<td>Patient status = completed; Exam not “Ready to View?” in exam list</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Read/write access to ImageRoot folder</td>
<td>SmartScan STUDIO Manager “rescan” fails</td>
</tr>
<tr>
<td>DEXIS i-CAT FLX Client</td>
<td>SmartScan STUDIO Client</td>
<td>Web access to scanner controller</td>
<td>No response from device when creating an exam</td>
</tr>
</tbody>
</table>
SmartScan STUDIO Manager Status Indicators

SmartScan STUDIO Manager displays three status indicators in the top, right-hand corner of the display. Move the mouse over the indicator to display more detail about the status condition.

**Scanner** - indicates status of the connectivity between the workstation running SmartScan STUDIO Manager and the i-CAT FLX scanner controller.

**Database** -

- The first indicator shows status of the communication between the workstation running SmartScan STUDIO Manager and the SmartScan STUDIO Integration Services web service.
- The second indicator shows status of the communication between the workstation running SmartScan STUDIO Manager and the Image Root folder.

If a status check fails, the status indicator changes to a red X.

Refer to the table below for troubleshooting failed status indicator conditions. Contact Technical Support if problem is not corrected or the error persists.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Error Detail/Possible Causes</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scanner</td>
<td>No power to scanner controller</td>
<td>Cycle power on the scanner controller.</td>
</tr>
<tr>
<td></td>
<td>Connection Refused - IP address incorrect but machine is on network</td>
<td>Check that Scanner Connection address in Control Panel&gt;SmartScan STUDIO Integration Services is correct for the scanner controller and matches IP Address in Configurator&gt;Network.</td>
</tr>
<tr>
<td></td>
<td>Content Access Denied</td>
<td>Contact Technical Support.</td>
</tr>
</tbody>
</table>

**NOTE:** If both Database indicators show a failed state, the likely cause is that Image Root is not available. Start troubleshooting with Database (2nd).
<table>
<thead>
<tr>
<th>Indicator</th>
<th>Error Detail/Possible Causes</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database (1st)</td>
<td>No power to server computer</td>
<td>Cycle power on long-term storage server.</td>
</tr>
<tr>
<td></td>
<td>Connection Refused:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- IP address incorrect but machine is on network</td>
<td>Check that Integration Services Connection and Port in Control Panel&gt;SmartScan STUDIO Integration Services is correct for the long-term storage server (in command window at server, use <code>ipconfig</code> to obtain IPv4 address).</td>
</tr>
<tr>
<td></td>
<td>- Firewall blocking</td>
<td>Contact Technical Support or site IT.</td>
</tr>
<tr>
<td></td>
<td>Content Access Denied:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- SmartScan STUDIO Integration Services Web service down</td>
<td>Cycle power on the long-term storage server.</td>
</tr>
<tr>
<td></td>
<td>- Mismatched versions of SmartScan STUDIO and SmartScan STUDIO Manager</td>
<td>Check that versions match. If not, load correct software so that versions match.</td>
</tr>
<tr>
<td>Database (2nd)</td>
<td>Image Root location inaccessible</td>
<td>Cycle power to the computer storing Image Root.</td>
</tr>
<tr>
<td></td>
<td>- No power to Image Root computer or network down</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Image Root path is incorrect or changed</td>
<td>Check that Image Root Folder path in Control Panel&gt;SmartScan STUDIO Integration Services is correct for Image Root. The configuration settings entered on this window are broadcast to all client workstations that are configured to this host computer. Any changes to the configuration here will change the configuration of the client workstations pointing to this host computer.</td>
</tr>
<tr>
<td></td>
<td>- User permissions to connect to Image Root folder incorrect or insufficient</td>
<td>Check if Image Root is accessible at client computer by navigating to it using Windows Explorer. Make sure Image Root folder is shared and password protection removed. See i-CAT FLX Installation Manual, Appendix B for setup of alternative network configurations.</td>
</tr>
</tbody>
</table>
**Fixed IP Addresses**

**NOTE:** It is recommended that all site-provided servers and workstations use fixed IP addresses. SmartScan STUDIO Manager and Integration Services have to maintain continuous connection with the i-CAT FLX scanner controller. It is highly recommended that a fixed IP address, either static IP or DHCP Reservation, is assigned to the scanner controller to ensure a continuous connection. It is the responsibility of the site IT department to determine which method they want to use to assign IP addresses. Follow the appropriate procedures below based on the method the site IT department wants to use to assign IP addresses:

- Static IP Addresses
- DHCP Reservation Addresses

⚠️ **CAUTION**

If a fixed IP address cannot be obtained (site IT department wants to use DHCP (Dynamic) Addressing), the site should be made aware that, if the IP address changes, they may experience system down time and will have to contact Technical Support. This situation can be reduced if the site sets a longer DHCP lease time. However, it is highly recommended that fixed IP addresses are used.

---

**Obtain MAC Address of Scanner Controller**

If site IT personnel request the Media Access Control (MAC) address of the scanner controller, obtain this address as follows:

1. Log into SmartScan STUDIO and select **Configurator**.
2. Select **Network** option, then select **Show Full Network Details**.
3. Locate the **Physical Address** entry. Record physical address so that the site can assign a fixed IP address for the scanner controller.

---

**Configure Static IP Addresses**

1. Obtain the following addresses from the site IT department:
   - IP Address of scanner controller
Load Clinical Software and Configure System

- Subnet Mask
- Default gateway
- Preferred DNS server
- Alternate DNS server

2. Select Configurator, and then Network.

3. Select Use the following IP address option and enter IP addresses for the following:
   - IP Address (scanner controller)
   - Subnet mask
   - Default gateway

4. Select Use the following DNS server address option and enter addresses for the following:
   - Preferred DNS server
   - Alternate DNS server

5. Click Save.

Configure DHCP Reservation Addresses

NOTE: The site IT department can reserve IP addresses before they are obtained by the Configurator, or reserve them after they have been obtained by the Configurator.

Addresses are Reserved in Advance:

1. Select Configurator, and then Network.
2. Select Obtain an IP address automatically and Obtain DNS server address automatically options.
3. Click Save.
4. Close Configurator, then restart it. The address fields should be populated in the Configurator.
5. Verify with the site IT department that these addresses are correct and will always be assigned to the devices.

Addresses are Reserved After Obtained by Configurator:

1. Perform steps 1 - 4 above.
2. Record the IP and DNS server addresses in the five fields shown above. Request that the site IT department reserve them so that these addresses will always be assigned to the devices.

Risk of Changes to Site Network

The site IT department should be aware of the following:

1. Connection of the i-CAT FLX to the customer network/data coupling that includes other equipment could result in previously unidentified risks to patients, operators, or third parties.
2. The customer should identify, analyze, evaluate and control these risks.
3. Subsequent changes to the network/data coupling could introduce new risks and require additional analysis.

4. Changes to the network/data coupling include:
   • changes in network/data coupling configuration.
   • connection of additional items to the network/data coupling.
   • disconnecting items from the network/data coupling.
   • update of equipment connected to the network/data coupling.
   • upgrade of equipment connected to the network/data coupling.

Alternate Network Configurations

The following scenarios describe installation in a typical network environment. Appendix B contains instructions for setup of alternate configurations that may be necessary depending on site requirements.
**Scenario 1 - i-CAT FLX Installation**

Below is the installation sequence of system software. The diagram shows a possible site configuration with guidelines for the software that should be loaded on each workstation.

### Scenario 1 - i-CAT FLX Installation

1. **Install i-CAT FLX (Chapters 1 and 2)**
   - Scanner and controller installed and networked with IP address.
   - SmartScan STUDIO is pre-installed at the factory.

2. **Install SmartScan STUDIO Server Components (page 3-18)** on long-term storage server.
   - Integration Services (required by all sites)
   - PACS Storage Service (sites using PACS)
   - Legacy Practice Management Interface (sites using PM system)

3. **Install SmartScan STUDIO Client Components (page 3-21)** on workstations in front office, operatories, and consultation rooms.
   - SmartScan STUDIO Manager (required by all sites)
   - PACS QR (sites using a PACS for image storage)
   - PACS MWL (sites using modality worklists for scheduling patients)
   - Legacy Practice Management Viewer Launcher (sites using PM system)
   - Patient Data Utility (required by all sites for viewing QA Test results)
   - SmartScan STUDIO Twain Driver (32-bit) (for sites using a Twain interface to connect to scanner)

4. **Configure TxSTUDIO Software (page 3-24)** as required. For workstations running other supported viewers, refer to the vendor’s documentation for additional system requirements.
   - If not already loaded, load on workstations that will be using it to view patient images, as purchased by the site.
   - **NOTE:** Vision is not supported on the i-CAT FLX.
Scenario 2 - Replace Existing i-CAT 17-19 or KaVo 3D eXam with an i-CAT FLX (without DEXIS)

This installation scenario is similar to an i-CAT FLX installation except that the existing ImageRoot must be moved to the site-provided server prior to installing the i-CAT FLX. Use the following sequence:

<table>
<thead>
<tr>
<th></th>
<th>Move existing ImageRoot</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>If the existing ImageRoot is located on the old workstation or a location that will not be part of the new i-CAT FLX configuration, it must be moved to the long-term storage server that will serve the new i-CAT FLX configuration.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> Only connect an existing ImageRoot to an i-CAT FLX system if the existing ImageRoot patient data was generated in English.</td>
</tr>
<tr>
<td></td>
<td>1. Identify UNC location for new ImageRoot.</td>
</tr>
<tr>
<td></td>
<td>2. Verify that all Viewer workstations and the long-term storage server have read / write access to the new ImageRoot location.</td>
</tr>
<tr>
<td></td>
<td>3. Quit all Viewer sessions that may be accessing data in the old ImageRoot. Ensure the Sweeper service in not active.</td>
</tr>
<tr>
<td></td>
<td>4. Remove the entire (ServerStatus) folder from the old ImageRoot.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> If the folder cannot be removed, determine if a viewer is accessing data in the old ImageRoot. Do not proceed until the folder can be removed.</td>
</tr>
<tr>
<td></td>
<td>5. Copy the existing ImageRoot data to the new location. Use a method that preserves the file and folder structure and ownership. Drag and Drop may not work depending how you are logged into the network. One option is to use the xcopy program on the old workstation to copy ImageRoot with the following command:</td>
</tr>
<tr>
<td></td>
<td>xcopy [existing ImageRoot location] [new ImageRoot location] /k /h /r /e /v</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Remove existing i-CAT 17-19 or KaVo 3D eXam equipment</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Remove the existing i-CAT 17-19 or KaVo 3D eXam scanner, acquisition computer, and control box.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Install i-CAT FLX (Chapters 1 and 2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Scanner and controller installed and networked with IP address.</td>
</tr>
<tr>
<td></td>
<td>SmartScan STUDIO is pre-installed at the factory.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Install SmartScan STUDIO Server Components (page 3-18) on long-term storage server.</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>• Integration Services (required by all sites)</td>
</tr>
<tr>
<td></td>
<td>• PACS Storage Service (sites using PACS)</td>
</tr>
<tr>
<td></td>
<td>• Legacy Practice Management Interface (sites using PM system)</td>
</tr>
</tbody>
</table>
Load Clinical Software and Configure System

**Scenario 3 - New DEXIS - i-CAT FLX Installation**

**NOTE:** DEXIS is optional software and is not available in all countries.

Below is the installation sequence of system software. The diagram shows a possible site configuration with guidelines for the software that should be loaded on each workstation.

**Site Provided Server**
- DEXIS Server or Core
- SmartScan STUDIO Integration Services
- DEXIS i-CAT FLX Server Plugin
- (Optional) 4 - 5 if server is also a client

**Operator/Consultation Room**
- DEXIS Client
- DEXIS i-CAT FLX Client
- SmartScan STUDIO Manager
- Patient Data Utility
- Supported Viewer

**NOTE:** Vision is not supported on the i-CAT FLX.
### Scenario 3 - New DEXIS - i-CAT FLX Installation

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
</table>
| **1** | **Install i-CAT FLX** *(Chapters 1 and 2)*  
Scanner and controller installed and networked with IP address.  
SmartScan STUDIO is pre-installed at the factory. |
| **2** | **Install DEXIS**  
Install and Configure DEXIS Imaging Suite 10 for Server and Client  
The DEXIS Imaging Suite media contains both server and workstation components of the software. You will be prompted during installation to select an installation type.  
- For the long-term storage server: select **Server and Workstation** installation.  
- For clinical workstations the run DEXIS: select **Workstation** installation.  
Refer to the *DEXIS Imaging Suite Software Manual* for instructions.  
**-OR-**  
Install and Configure DEXIS Core and DEXIS Eleven client software:  
- Install the DEXIS Core media on the server that functions as the long-term data storage device.  
- Install DEXIS Eleven client software media on all clinical workstations that are using DEXIS. DEXIS Eleven client software can also be installed on the server that functions as the long-term data storage device on a shared server-client.  
Refer to the *DEXIS Eleven Software Manual* for instructions. |
| **3** | **Install SmartScan STUDIO Server Components** *(page 3-18)* on long-term storage server.  
- Integration Services (required by all sites)  
- PACS Storage Service (sites using PACS)  
- Legacy Practice Management Interface (sites using PM system)  
- Data Utility for DEXIS 10 or DEXIS 11 (optional)  
- DEXIS i-CAT FLX Server Plugin for DEXIS 10 or DEXIS 11 (required for all DEXIS sites)  
**NOTE:** For a Shared Server - Client installation scenario, you must also load the DEXIS i-CAT FLX Client on the server (located on Client Components media). For a Separate Server - Client installation scenario, load the DEXIS i-CAT FLX Client component on the server only if the site plans to use the server as a client. |
| **4** | **Install SmartScan STUDIO Client Components** *(page 3-21)* on workstations in front office, operatories, and consultation rooms.  
- SmartScan STUDIO Manager (required on one workstation for accessing QA test images)  
- PACS QR (sites using a PACS for image storage)  
- PACS MWL (sites using modality worklists for scheduling patients)  
- Legacy Practice Management Viewer Launcher (sites using PM system)  
- DEXIS i-CAT FLX Client (required for all DEXIS sites)  
- Patient Data Utility (required by all sites for viewing QA Test results)  
**NOTE:** The SmartScan STUDIO Twain option is not needed when using DEXIS or a PM system. |
| **5** | **Configure TxSTUDIO Software** *(page 3-24)* as required. For workstations running other supported viewers, refer to the vendor’s documentation for additional system requirements.  
If not already loaded, load on workstations that will be using it to view patient images, as purchased by the site.  
**NOTE:** Vision is not supported on the i-CAT FLX. |
Scenario 4 - Upgrade Existing DEXIS (without i-CAT 17-19 or KaVo 3D eXam) with DEXIS - i-CAT FLX

NOTE: DEXIS is optional software and is not available in all countries.

Sites must be running DEXIS 10 or later to be able to integrate with the i-CAT FLX and SmartScan STUDIO. For sites that are running earlier versions of DEXIS, follow the sequence below. For sites already running a supported version of DEXIS, skip step 2. The diagram shows a possible site configuration with guidelines for the software that should be loaded on each workstation.
### Scenario 4 - Upgrade Existing DEXIS (without i-CAT 17-19 or KaVo 3D eXam) with DEXIS - i-CAT FLX

<table>
<thead>
<tr>
<th>Step</th>
<th>Task Description</th>
</tr>
</thead>
</table>
| 1    | **Install i-CAT FLX (Chapters 1 and 2)**  
Scanner and controller installed and networked with IP address.  
SmartScan STUDIO is pre-installed at the factory. |
| 2    | **NOTE:** Make sure there are no pending scans before beginning a DEXIS upgrade. Do not use DEXIS until the SmartScan STUDIO components are installed.  
**Upgrade to DEXIS Imaging Suite 10**  
Install DEXIS Imaging Suite 10 for Server and Client  
For current DEXIS sites that are running a version earlier than DEXIS 10, install the latest version of DEXIS Imaging Suite 10 on the long-term storage server and on all clinical workstations that are using DEXIS. Refer to *DEXIS Imaging Suite Software Manual* for instructions.  
The DEXIS Imaging Suite media contains both server and workstation components of the software. You will be prompted during installation to select an installation type.  
  - For the server that functions as the long-term data storage device: select **Server and Workstation** installation.  
  - For clinical workstations that run DEXIS: select **Workstation** installation.  
  **Convert Image Database:**  
DEXIS Imaging Suite 10 uses a different image database than previous versions of DEXIS. Follow instructions in *DEXIS Software to Imaging Suite Database Import Utility User Manual* for detailed instructions.  
**-OR-**  
**Upgrade to DEXIS Core / DEXIS Eleven**  
Install and Configure DEXIS Core and Migrate Data:  
DEXIS Eleven uses a different image database than previous versions of DEXIS. Using the DEXIS Core media, install DEXIS Core on the server that functions as the long-term data storage device and migrate existing patient data. Refer to the *DEXIS Eleven Software Manual* for instructions.  
**Install DEXIS Eleven client software:**  
Using the DEXIS Eleven media, install DEXIS client software on all clinical workstations that are using DEXIS. DEXIS Eleven client software can also be installed on the server that functions as the long-term data storage device on a shared server-client. Refer to the *DEXIS Eleven Software Manual* for instructions. |
| 3    | **Install SmartScan STUDIO Server Components (page 3-18)** on long-term storage server.  
  - Integration Services (required by all sites)  
  - PACS Storage Service (sites using PACS)  
  - Legacy Practice Management Interface (sites using PM system)  
  - Data Utility for DEXIS 10 or DEXIS 11 (optional)  
  - DEXIS i-CAT FLX Server Plugin for DEXIS 10 or DEXIS 11 (required for all DEXIS sites)  
  **NOTE:** For a Shared Server - Client installation scenario, you must also load the DEXIS i-CAT FLX Client on the server (located on Client Components media). For a Separate Server - Client installation scenario, load the DEXIS i-CAT FLX Client component on the server only if the site plans to use the server as a client. |
<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
</table>
| **4** | **Install SmartScan STUDIO Client Components (page 3-21)** on workstations in front office, operatories, and consultation rooms.  
  - SmartScan STUDIO Manager (required on one workstation for accessing QA test images)  
  - PACS QR (sites using a PACS for image storage)  
  - PACS MWL (sites using modality worklists for scheduling patients)  
  - Legacy Practice Management Viewer Launcher (sites using PM system)  
  - DEXIS i-CAT FLX Client (required for all DEXIS sites)  
  - Patient Data Utility (required by all sites for viewing QA Test results)  
  **NOTE:** The SmartScan STUDIO Twain option is not needed when using DEXIS or a PM system. |
| **5** | **Configure TxSTUDIO Software (page 3-24)** as required. For workstations running other supported viewers, refer to the vendor's documentation for additional system requirements.  
  If not already loaded, load on workstations that will be using it to view patient images, as purchased by the site.  
  **NOTE:** Vision is not supported on the i-CAT FLX. |
Install and Configure Clinical Software

Install SmartScan STUDIO Server Components

SmartScan STUDIO Integration Services should be loaded on the server that will be used as the long-term data storage device. Load Data Utilities, Legacy Practice Management Interface, and PACS Storage Service as needed by the site.

**NOTE:**
- During installation, acknowledge any Microsoft User Account Control notifications that may be displayed to continue installation.

⚠️ **CAUTION**

Be sure to load SmartScan STUDIO Integration Services on only one workstation at a site, which should be the server that will be used as the long-term data storage device. Workflow at client workstations will be impacted if an invalid Integration Services server is configured.

1. At server, insert media in drive.
2. On AutoPlay pop-up, select **Run SssInstallerExecutive.exe**. If AutoPlay pop-up does not display, navigate to the media drive, right-click and select **Open AutoPlay**.
3. On the SmartScan STUDIO Installer Executive:
   a. Select programs to be installed.

   - Integration Services (required)
   - PACS Storage Service (for sites using a PACS for image storage)
   - Legacy Practice Management Interface (for sites using a supported PM system)
   - Data Utility for DEXIS 11 (optional)
   - DEXIS i-CAT FLX Server Plugin for DEXIS 11 (for sites using DEXIS Eleven)
Load Clinical Software and Configure System

• Data Utility for DEXIS 10 (optional)
• DEXIS i-CAT FLX Server Plugin for DEXIS 10 (for sites using DEXIS Imaging Suite 10)

NOTE: The Legacy Practice Management Interface and the DEXIS i-CAT FLX Server Plugin cannot be installed on a computer at the same time.

b. Click Install.

c. Click Yes on the confirmation dialog. The discovery service prepares for installation. If the required .NET framework and Visual C++ packages are not installed, the required files will be loaded. This may take a few minutes.

4. Follow prompts to load all selected programs.

5. On SmartScan STUDIO Installer Executive, check that all selected programs have been installed, then click Close. Remove media.

NOTE: The ImageRoot folder must be accessible to all client computers. The folder should be shared and any password protection removed to ensure clients can access it, following the steps below. Contact Technical Support if site network setup does not allow this.

6. To share the Image Root Directory with all users:

a. Open Control Panel and select Folder Options or File Explorer Options.
b. On the General tab, enable Show all folders (if option is available).
c. On the View tab, enable Show hidden files, folders, and drives. Click OK.
d. Navigate to ProgramData\Dental Imaging Technologies Corporation (or to the location where the Image Root directory resides).
e. Right-click ImageRoot folder, and select Share with->Specific people from the pop-up menu.
f. Enter or select Everyone, and click Add.
g. Ensure Permission Level is set to Read/Write for Everyone. If not, select Read/Write from drop-down menu.
h. Click Share.
i. Click Yes if prompted to turn on network discovery and file sharing, then click Done.
j. Right-click on ImageRoot folder and select Properties.
k. On the Sharing tab, click Network and Sharing Center link.
l. Click arrow next to All Networks to display options.
m. Under Password protected sharing, select Turn off password protected sharing.
n. Click Save changes.
o. Close Properties window.

7. Check settings on SmartScan STUDIO Integration Services Configuration:

NOTE: The configuration settings entered on this window are broadcast to all client workstations that are configured to this host computer. Any changes to the configuration here will change the configuration of the client workstations pointing to the host computer.
a. Open Control Panel and select **SmartScan STUDIO Integration Services**.

b. Check that Integration Services Connection shows name (computer name is default) and address of the Integration Services server. You can enter a unique name (will not change the computer name). When setting up SmartScan STUDIO Manager or DEXIS - i-CAT FLX on client workstations, be sure name or address specified in these fields is selected.

c. Ensure scanner is connected. **Automatic By Name** (default) connects to the scanner controller location by computer name. This prevents connection problems caused by changing IP addresses. Some network setups may not be able to resolve the computer name, and will have to use an IP address (for example, computers on different subnets).

When required, select **Manual By Address** and ensure connection to the scanner by IP address. A fixed IP address should be used. See **Fixed IP Addresses (page 3-8)** for additional information.

d. Check that Image Database Folder is specified.

   • The Image Root network location is defined by computer name by default. The computer name of the host computer (long-term storage server) must be accessible by all client computers. Otherwise, the Image Root location must be defined by IP address.

   • If the Image Root network path must be defined by IP address, enter the IP address for the Image Root computer in format: `\xxx.xxx.xxx.xxx\ImageRoot`. The host computer (long-term storage server) should be assigned a fixed IP address. Otherwise, connection to the Image Root will be lost when the IP address changes.

e. Ensure the **Prevent SmartScan STUDIO Manager Exam Submission** checkbox is set as required based on the site workflow.

   • If the site is using SmartScan STUDIO Manager to submit exams, ensure the checkbox is unchecked.

   • If the site is using PACS Storage Services and/or Legacy Practice Management Interface to submit exams, ensure the checkbox is checked.

   • If DEXIS is installed, the checkbox is automatically checked and the option is greyed out.

f. If the site wants to automatically delete raw projection data older than a specified number of days since acquisition, select the checkbox and enter the number of days. The default is 30 days. If this option is not selected (default), raw projection data will not be automatically deleted.
Load Clinical Software and Configure System

If DEXIS is installed:

- For DEXIS Imaging Suite 10, check that the location of the DEXIS data directory is displayed.

- For DEXIS Eleven, select ... next to Practice URL, then select the Practice URL from the dialog. Enter the Username and Password for the server, then select Test to ensure the connection is established. Click OK on the pop-up.

Click Save & Restart. A message is displayed “Restarting Integration Services. Please wait (up to 10 minutes).”

NOTE:

- If the PACS Storage Service was loaded, and has not been set up, you will get a PACS Station error message when closing this window. See Configure SmartScan STUDIO PACS Modules (Optional) (page 3-26) for additional setup instructions.

- If the Legacy Practice Management Interface was loaded, refer to Configure Legacy Practice Management Interface (Optional) (page 3-30) for additional setup instructions.

- For sites using Data Utility, additional setup is required. After all software is loaded, see i-CAT FLX Technical Guide for additional setup instructions.

Install SmartScan STUDIO Client Components

SmartScan STUDIO Manager should be loaded on any workstation where the site will be entering patient exam data or viewing patient images. For sites that use a PACS, load the required SmartScan STUDIO PACS software on each workstation. For sites that use a supported PM system, load the Legacy Practice Management Viewer Launcher on all workstations that use it.

1. At clinical workstation, insert media in drive.

2. On AutoPlay pop-up, select Run SssInstallerExecutive.exe. If AutoPlay pop-up does not display, navigate to the media drive, right-click and select Open AutoPlay.

3. On the SmartScan STUDIO Installer Executive:
a. Select programs to be installed.

- SmartScan STUDIO Manager (required)
- PACS QR - for sites using a PACS for image storage. Can be installed on both the workstation and the server.
- PACS MWL - for sites using modality worklists for scheduling patients. Can be installed on both the workstation and the server.
- Legacy Practice Management Viewer Launcher (for sites using a supported PM system)
- DEXIS i-CAT FLX Client (for sites using DEXIS)
- Patient Data Utility (required by all sites for viewing QA Test results)
- SmartScan STUDIO Twain Driver (32-bit) (for sites using a Twain interface to connect to scanner)

NOTE: The Twain interface is disabled if the site has DEXIS or a Legacy Practice Management system installed.

b. Click Install.

c. Click Yes on the confirmation dialog. The discovery service prepares for installation. This may take a few minutes.

4. Follow prompts to load all selected programs.

5. On SmartScan STUDIO Installer Executive, check that all selected programs have been installed, then click Close. Remove media.

6. Launch SmartScan STUDIO Manager from desktop:
   a. Select to access Settings.
b. Select image viewer to be used on the workstation.

c. Check that Scanner and Image Database Folder locations match what is displayed in SmartScan STUDIO Integration Services Configuration window.

d. Check Integration Services Connection options.

- **Automatic by Name** (Default) - This is the preferred option. Connects to SmartScan STUDIO Integration Services server location by computer name. This prevents connection problems caused by changing IP addresses. This field must match the name in SmartScan STUDIO Integration Services Configuration window. Some network setups may not be able to resolve the computer name, and will have to use an IP address (for example, computers on different subnets).

- **Manual by Address** - When required, select this option to specify the server running SmartScan STUDIO Integration Services by IP address and Port (must match address/port in SmartScan STUDIO Integration Services Configuration window). A fixed IP address should be used. See **Fixed IP Addresses (page 3-8)** for additional information.

e. Check the status indicators at the top of the main window. All indicators should display **OK**. If not, go to SmartScan STUDIO Manager Status Indicators (page 3-6) and troubleshoot.

f. Click and close SmartScan STUDIO Manager.

7. For DEXIS sites, check settings on DEXIS i-CAT FLX Configuration:
a. Open Control Panel and select **DEXIS i-CAT FLX**.

b. Check Integration Services Connection options. **Automatic By Name** (default) connects to SmartScan STUDIO Integration Services server location by computer name. This prevents connection problems caused by changing IP addresses. Some network setups may not be able to resolve the computer name, and will have to use an IP address (for example, computers on different subnets).

When required, select **Manual By Address** option to specify the server running SmartScan STUDIO Integration Services by IP address and Port (must match address/port in SmartScan STUDIO Integration Services Configuration window). A fixed IP address should be used. See **Fixed IP Addresses (page 3-8)** for additional information.

c. Check that Scanner and Image Database Folder locations match what is displayed in SmartScan STUDIO Integration Services Configuration window. Click **OK**.

**NOTE:**
- Additional setup is required for the Patient Data Utility at all sites. See **Configure Patient Data Utility (page 3-26)** for additional setup instructions.
- For sites using a PACS, additional setup is required. After all software is loaded, see **Configure SmartScan STUDIO PACS Modules (Optional) (page 3-26)** for additional setup instructions.
- For sites using a Twain interface to connect to the scanner, additional setup is required. After all software is loaded, see **Set Up SmartScan STUDIO Twain Driver (Optional) (page 3-32)**.

### Configure TxSTUDIO Software

**NOTE:** If TxSTUDIO software is already loaded and configured on all workstations requiring it, skip this section.

TxSTUDIO should be loaded on workstations that will be using it to view patient images, as purchased by the site. For sites that want to share workups among workstations, a shared folder must be created on the long-term storage server and TxSTUDIO configured so that all workups will be saved to this location. This will ensure that all users can access workups from any workstation that has TxSTUDIO loaded.

1. At the long-term storage server, create a folder named **TxSTUDIO Cases** that can be shared by all the site workstations that will use TxSTUDIO. Ensure that all workstations running TxSTUDIO have read/write permissions to this location. Coordinate with site IT personnel if necessary.

2. To download TxSTUDIO from the website:
   a. Ensure there is an Internet connection at the workstation. Insert media in drive where downloaded files will be copied.

   **NOTE:** You can also download TxSTUDIO to a shared network location.
b. Go to www.anatomage.com, then click on Dr. Login. Contact Technical Support for username and password, and also for the authorization code(s) for each copy of TxSTUDIO to be loaded.

c. Download the latest TxSTUDIO installer to the media and remove media.

3. Load TxSTUDIO on all workstations that will be used to view patient images:

   NOTE: TxSTUDIO installations are limited to the number of licenses held by the site (default of 6).

   a. At clinical workstation, insert media in drive. Access the TxSTUDIO installer from the AutoPlay dialog box. If AutoPlay does not display, navigate to the media drive and double-click the TxSTUDIO installer. Installation files are extracted.

   b. TxSTUDIO runs a check of the computer to look for required components. If all Results = Pass, click Next. Otherwise, TxSTUDIO may not work properly on that workstation. Workstations should meet minimum system requirements for TxSTUDIO. Refer to the TxSTUDIO Reference Manual for more information.

   c. When prompted, enter the authorization code listed on the media cover or obtained from Technical Support. Click Next.

   d. On Select Installation Folder screen, use the default location. Click Next.

   e. On License Agreement screen, select accept and click Next.

   f. On Ready to Install screen, click Install. Installation will start and a progress bar is displayed.

   g. Click Finish when installation is complete and close window. Check that the icon is on the desktop and remove media.

   NOTE: Exclusions should be added for TxSTUDIO in AVG or other internet security software running on the workstation.

4. For sites that want to share workups among workstations, configure TxSTUDIO to use TxSTUDIO Cases folder:

   a. Start TxSTUDIO.

   b. On the File Manager window, click Cancel.

   c. Select File->Preference.

   d. Click File Manager tab.

   e. Select Dicom and click Change Anatomage Case Path. Navigate to the location where the TxSTUDIO Cases folder was created. Repeat for the Change Default Open Path and Change Default Save Path.

   f. Click OK to apply the changes and close Preferences.

   g. Select File->Preference. Click File Manager tab.

   h. Select Invivo and repeat steps e and f.
NOTE: Make sure to keep the Invivo button selected in File Manager preferences so files will be saved in .inv format.

i. Close TxSTUDIO.

5. Repeat steps 3 and 4 for all workstations that require TxSTUDIO.

**Configure Patient Data Utility**

The Patient Data Utility is used by all sites for view QA test results. It must be configured to point to the image root location before it can be used.

1. Select the Start menu and right-click Patient Data Utility on the menu. Select Properties, then select the Compatibility tab. Select the Run this program as an administrator and click OK. The utility will now run with administrator privileges every time it is launched.

**NOTE:** It is recommended that you pin the utility to the Start menu. The utility can also be launched from All Programs>Dental Imaging Technologies Corporation>Patient Data Utility.

2. To start the utility, select the Start menu, then Patient Data Utility.

3. On initial startup, a message is displayed indicating the image root location is not found. Click OK.

4. On the Patient Data Utility window, select Settings, then Configuration.

5. On Configuration window, click button and browse to the ImageRoot folder that contains the patient data. (Typically, this is ProgramData\Dental Imaging Technologies Corporation\ImageRoot).

6. Select the ImageRoot and click OK.

7. Click OK to close the Configuration window.

**Configure SmartScan STUDIO PACS Modules (Optional)**

For sites that use a PACS (Picture Archiving Communication System) for storing images, or use a RIS (Radiology Information System) to maintain patient data, configure the optional SmartScan STUDIO PACS software on the clinical workstations.

**PACS Configurator Settings**

**NOTE:** The PACS Storage software should have been loaded during the installation of SmartScan STUDIO Server components. Install it from the SmartScan STUDIO Server media if it is not installed.
1. On Control Panel, select SmartScan STUDIO Integration Services, then select **PACS** tab.

**NOTE:** Coordinate with the site PACS administrator for the data to be entered in these fields.

2. In **Remote Server** section (this is the PACS Server):
   a. Enter Station name (user defined for identifying a particular PACS server setup). Enter IP Address, AE Title, Port Number (obtain from PACS administrator).
   b. Select a state (active or inactive).
   c. Click **Save**.
   d. Click **Test** to perform DICOM validation (C-ECHO) to check whether the remote server is accessible.

3. In **Local Settings** section (this is the SmartScan STUDIO long-term storage server):
   a. Enter the Local AE Title for the SmartScan STUDIO long-term storage server.
   b. Select the amount of time (in seconds) for a time out (range 10 - 60 seconds). Also enter the time to wait after a send operation fails before trying again (range 10 - 60 seconds) and the number of times to retry a failed send operation (maximum 5). The status of a send operation is displayed in the SmartScan STUDIO Manager Exam List under the PACS Status heading.

4. In **Transfer Syntax Negotiated** section, select transfer syntax(es) to be used to send CT/PAN datasets to the selected PACS server. Multiple options can be selected and at least one option must be selected.
   - JPEG Lossless
   - Little Endian Explicit VR (Value Representation)
   - Little Endian Implicit VR

   The transfer syntax(es) selected should be based on the compatibility and/or preference of the PACS configuration.

5. In the Storage Commitment section, select the **Perform Storage Commitment** checkbox if you want to enable storage commitment of sent DICOM images. When selected, two radio buttons become active:
   - Select **Use Existing Connection** to use the same connection for sending a Storage Commitment request and receiving a Storage Commitment response from the PACS server.
   - or -
   - Select **New Connection** to receive Storage Commitment responses on a new connection initiated by the PACS. In the **New Connection Configuration** section, enter the IP Address and Port for the server that will send the Storage Commitment response.
A Storage Commitment request is sent after all the DICOM files of a study are sent successfully. The status of a Storage Commitment operation is displayed in the SmartScan STUDIO Manager Exam List under the PACS Status heading.

6. Click **OK**.

**Modality Worklist Settings**

**NOTE:** The Modality Worklist software should have been loaded during the installation of SmartScan STUDIO Client components. Install it from the SmartScan STUDIO Client media if it is not installed.

1. Start SmartScan STUDIO MWL.  
   **NOTE:** Coordinate with the site RIS administrator for the data to be entered in these fields.

2. Click **Config** (remote RIS configuration settings).
   a. Enter Station name (user defined for identifying a particular PACS server setup). Enter IP Address, AE Title, and Port number for the RIS server, from where patient data is retrieved. This information should be provided by hospital IT or RIS administrator.
   b. Click **Save**, then **Close**.
3. Click **Options**.
   a. Under Integration Service Connection, select one of the following:
      • **Automatic by Name** (Default) - This is the preferred option. Connects to SmartScan STUDIO Integration Services server location by computer name. This prevents connection problems caused by changing IP addresses. This field must match the name in SmartScan STUDIO Integration Services Configuration window. Some network setups may not be able to resolve the computer name, and will have to use an IP address (for example, computers on different subnets).
      • **Manual by Address** - When required, select this option to specify the server running SmartScan STUDIO Integration Services by IP address and Port (must match address/port in SmartScan STUDIO Integration Services Configuration window). A fixed IP address should be used. See **Fixed IP Addresses** (page 3-8) for additional information.
   b. To retrieve scheduled patient data from the remote RIS server automatically, select **Auto Retrieve Patients On Load** checkbox.
   c. Select desired date format and AE Title for the local computer.
   d. Click **OK**.

**Query/Retrieve Settings**

**NOTE:** The Query/Retrieve software should have been loaded during the installation of SmartScan STUDIO Client components. Install it from the SmartScan STUDIO Client media if it is not installed.

1. Start SmartScan STUDIO Query/Retrieve Module.

**NOTE:** Coordinate with the site PACS administrator for the data to be entered in these fields.
2. Click Config (PACS Server configuration settings):
   a. Enter Station name (user defined for identifying a particular PACS server setup). Enter IP Address, AE Title, and Port number for the remote PACS server (obtain from PACS administrator), from where studies are to be queried and retrieved.
   b. Click Save, then Close.

3. Click Options.

4. Click Browse, and browse to the Image Root folder to select it as the default storage location on the local workstation.

5. In DICOM section, enter Receiving Port, Receiving IP Address, and Local AE title. This data must match the data for the Query/Retrieve (PACS) server side so that the two machines can communicate.

6. In Select Allowable Transfer Syntax(es) for Retrieving Datasets section, select transfer syntax(es) to be accepted for retrieving datasets from a PACS. Usually the transfer syntax(es) selected for sending datasets to a PACS should be selected for retrieval as well. Multiple options can be selected, and at least one option must be selected.
   - JPEG Lossless
   - Little Endian Explicit VR (Value Representation)
   - Little Endian Implicit VR

   The transfer syntax(es) enabled should be based on the compatibility and/or preference of the PACS configuration from which the datasets are retrieved.

7. In Misc. section, select the desired date format to be used. If you want the SmartScan STUDIO QR window to close after retrieving a study, select the Close after a successful retrieval checkbox.

8. Click Save.

Configure Legacy Practice Management Interface (Optional)

For sites that use a Practice Management system, configure the optional PM Interface software on the server. Refer to the i-CAT FLX User Manual for information about status messages that can be displayed.
NOTE:

- The Practice Management software should have been loaded during the installation of SmartScan STUDIO Server and Client components. Install it from the SmartScan STUDIO Server media and Client media if it is not installed.

- Coordinate with the site PM system administrator for the options to be selected for the site.

- If the PM system and SmartScan STUDIO Integration Services are on different computers, coordinate with site IT to ensure that Windows share permissions allow file sharing between the computers. The PM.xml file must be accessible to SmartScan STUDIO and the PM system.

1. On Control Panel, select SmartScan STUDIO Integration Services, then select **PM Interface** tab.

2. Enter or browse to the location of the PM.xml file. The PM.xml file is generated by the Patient Management system.

3. In Advanced Cleanup Options (only one option is selectable at a time):
   - **Automatically Clean PM.xml File** - When selected, removes an exam from the PM.xml file after it is selected on the Scheduled Exam screen. Select this option only if the PM system does not perform cleanup itself. The PM system has to allow writing to the PM.xml file.
   - **Remove Orphaned Exams from PM.xml File** - When selected (default), automatically removes completed exams from the PM.xml file after at least 30 days. Orphaned exams are completed, but contain no CT or PAN scans. This can happen when an exam is canceled or when only scouts are taken.

**NOTE:** If PM Exam Output is disabled, it is recommended that one of the Advanced Cleanup Options be selected.

4. **Disable All PM Exam Output** - When selected, disables the creation of the PM interface return path folder and all of its contents. This option may be used if a site does not use the PM system for storing images.
5. In Study Path Options:

   **NOTE:** The Study Path (Image Database Folder) must be defined for a supported viewer for it to be able to display exam images. Each viewer may obtain this path in a different way from different PM systems. An absolute path should work in most situations, where the study path retrieved from the return XML file is passed as-is to the viewer. If the viewer cannot locate exam images in this way, a relative path must be defined.

   - **Absolute** (default) - Obtains the path for the Image Database Folder location from the return XML file. No additional configuration is needed. Be sure that this option works with all viewers that will be used with the PM system. Otherwise, define a relative path.
   - **Relative** - When selected, adds the Image Database Folder location to the front of the study path that is provided to the viewer. The Image Database Folder location must be defined in the SmartScan STUDIO Launcher Configuration for this purpose.
     a. From the Start menu, select **All Programs>Dental Imaging Technologies Corporation>SmartScan STUDIO LPM_Launcher**.
     b. Enter or browse to the Image Database Folder path.
     c. Click **OK**.

6. Click **Save & Restart** on SmartScan STUDIO Integration Services.

**Set Up SmartScan STUDIO Twain Driver (Optional)**

For sites using a Twain interface to connect to the scanner, configure the SmartScan STUDIO Twain Interface software.

1. Coordinate with the site PMS administrator to acquire a scan image from the PMS using the FLX Twain source.

2. When the scan is initiated, the SmartScan STUDIO Twain Interface will display. Ensure that the server running Integration Services can be selected in the Twain Interface and a connection is made.
   - **Automatic by Name** (Default) - This is the preferred option. Connects to SmartScan STUDIO Integration Services server location by computer name. This prevents connection problems caused by changing IP addresses. This field must
match the name in SmartScan STUDIO Integration Services Configuration window. Some network setups may not be able to resolve the computer name, and will have to use an IP address (for example, computers on different subnets).

- **Manual by Address** - When required, select this option to specify the server running SmartScan STUDIO Integration Services by IP address and Port (must match address/port in SmartScan STUDIO Integration Services Configuration window). A fixed IP address should be used. See **Fixed IP Addresses (page 3-8)** for additional information.

3. When connected, click **Request Scan**.

4. In SmartScan STUDIO, ensure that the Favorites screen shows two PAN protocols only. Run a PAN scan through to completion.

5. Ensure that the PAN scan image is sent back to the PMS for the scan request, and is associated with the correct patient.

**Installation Check**

**NOTE:** Language and locale settings for the scanner controller, server and client workstations can be changed to support local languages. See **Language and Locale Settings (page 1-16)** if these settings need to be changed to a supported language.

**Installation Check for i-CAT FLX Installation**

1. At clinical workstation, enter data for a test patient and schedule exam.

2. At scanner controller, capture a scan for test patient.
   a. Set up a phantom on the scanner.
   b. Access **Acquire**.
   c. Select **TestPatient** from Scheduled Exams list and press .
   d. Select a protocol and press .
   e. Take a scan.
   f. Review image and press to complete.

3. At clinical workstation, locate test patient data.

4. View scan in TxSTUDIO and ensure correct path to the TxSTUDIO Cases folder displays in File Manager, or view in Dolphin.

**Installation Check for a DEXIS i-CAT FLX Installation**

1. Start DEXIS.

2. In DEXIS, enter data for a test patient.
   a. Select New Patient icon.
   b. Enter data for the patient and exam. Example: Enter **Test** for Last Name and **Patient** for First Name.
   c. Select **OK**.
d. Click (Extra-oral) and click I Accept on disclaimer pop-up message.

e. Click 3D. Click Later on registration pop-up message.

f. A pop-up message displays that patient is scheduled for acquisition. Click OK to dismiss.

3. In SmartScan STUDIO, capture a scan for test patient.

   a. Set up a phantom in the scanner.
   b. At scanner controller, access Acquire option.
   c. Select Test Patient from Scheduled Exams list and press .
   d. Select a protocol and press .
   e. Take a scan.
   f. Review image and press to complete.

4. In DEXIS, locate Test Patient exam in Extra-oral display.

5. Double-click the i-CAT box to start TxSTUDIO and load exam.

6. View scan in TxSTUDIO and ensure correct path to the TxSTUDIO Cases folder displays in File Manager.
Run QA Tests

Run the following QA Tests. See Service Menu Options chapter for instructions on logging in and accessing Utilities.

- QA Line Pair Test
- QA Material Test
- QA Air Water Test
- QA Pan Test

⚠️ CAUTION ⚠️

If the optional deadman handswitch is installed on the scanner, press and hold handswitch before pressing the Scan button, and continue to hold handswitch down for the duration of the exposure (X-ray light on). Early release of the handswitch stops the exposure and the Fault light turns on. The patient will have to be re-scanned.

QA Line Pair Test

Set Up QA Phantom

1. Remove chin cup and insert phantom platform.

2. Place QA phantom on platform. Use a piece of foam beneath the phantom to elevate it. Make sure phantom is level.

3. Center the QA phantom on the platform with the air hole positioned at the left rear of the gantry. The embedded metal strips should align left to right.
4. Using the Alignment Lasers, adjust the platform height so that the horizontal laser is positioned at the center of the QA phantom. Make sure the phantom is centered left to right and front to back. Use the lasers to confirm.

Run QA Line Pair Test

1. From Utilities menu, select **QA Line Pair**.

2. Ensure phantom is set up properly, then press .

3. Select , then press . The scanner initializes.

4. When prompted, press the **Scan** button on the operator control box. An audible alarm is sounded and the X-ray ON light is illuminated during radiation exposure.

5. Review the scout image. The phantom must be centered and level. Adjust the phantom platform as needed to achieve the proper height.

6. To move the phantom to the right or left, use the **Front/Back** slider control.

   If required, make adjustments, then press to run again. Repeat as required until phantom is properly aligned.

7. When phantom is aligned, select and press .

8. When prompted, press the **Scan** button on the operator control box. An audible alarm is sounded and the X-ray ON light is illuminated during radiation exposure. The scanner acquires data and a status indicator shows acquisition and image creation progress. When image processing is complete, image is displayed.

9. Review image to ensure adequate quality. Press to display Complete screen and select option to go Back to Utility.
QA Line Pair Evaluation

**NOTE:** It may take a few minutes for the scan you acquired to be available for viewing. Opening the Patient Data Utility locks the image database (Image Root). If the scan is not displayed in the Patient Data Utility list, close the utility to release the lock, then restart it in a few minutes.

1. At a clinical workstation, start Patient Data Utility. Select the **QA Scans Only** checkbox so that only the QA scans will be displayed in the Name list.

2. Select **QA Line Pair** from the list on the left, then select the most recent Volume scan from the corresponding study list. Output files are listed on the right side of the display.

3. For QA Line Pair evaluation, select the output file **QAResults** to view the results.

4. Check the results below the image. Ensure both the minMTF and Distance tests show PASS. If either test failed, contact Technical Support.

5. If desired, select **Save As** to save a copy of the output image to another location or select **Print** to print the output image. Close image when finished, and close the Patient Data Utility to release the lock.

QA Material Test

**Set Up QA Phantom**

Follow steps in [Set Up QA Phantom (page 4-1)](#), if phantom is not already in place.

**Run QA Material Test**

1. From Utilities menu, select **QA Material**.

2. Ensure phantom is set up properly, then press .

3. Select , then press . The scanner initializes.

4. When prompted, press the **Scan** button on the operator control box. An audible alarm is sounded and the X-ray ON light is illuminated during radiation exposure.
5. Review the scout image. The phantom must be centered and level. Adjust the phantom platform as needed to achieve the proper height.

6. To move the phantom to the right or left, use the **Front/Back** slider control.

   If required, make adjustments, then press **** to run **** again. Repeat as required until phantom is properly aligned.

7. When phantom is aligned, select **** and press ****.

8. When prompted, press the **Scan** button on the operator control box. An audible alarm is sounded and the X-ray ON light is illuminated during radiation exposure.

   The scanner acquires data and a status indicator shows acquisition and image creation progress. When image processing is complete, image is displayed.

9. Review image to ensure adequate quality. Press **** to display Complete screen and select option to go Back to Utility.

**QA Material Evaluation**

**NOTE:** It may take a few minutes for the scan you acquired to be available for viewing. Opening the Patient Data Utility locks the image database (Image Root). If the scan is not displayed in the Patient Data Utility list, close the utility to release the lock, then restart it in a few minutes.

1. At a clinical workstation, start Patient Data Utility. Select the **QA Scans Only** checkbox so that only the QA scans will be displayed in the Name list.

2. Select **QA Material** from the list on the left, then select the most recent Volume scan from the corresponding study list. Output files are listed on the right side of the display.

3. For QA Material evaluation, select the output file **QAResults** to view the results.

4. Check the results below the image. Ensure Material Plugs shows PASS. If test failed, contact Technical Support.

5. If desired, select **Save As** to save a copy of the output image to another location or select **Print** to print the output image. Close image when finished, and close the Patient Data Utility to release the lock.

**QA Air Water Test**

**Set Up QA Air Water Phantom**

**NOTE:** It is important to use the water phantom provided with the scanner. Use distilled water in the phantom. Using tap water may negatively affect the test results.
1. Remove chin cup and insert phantom platform at lowest position.

2. Fill phantom half full with distilled water and carefully place on platform.

3. Using the Alignment Lasers, center the water bath with the horizontal laser across the center of the water depth.

**Run QA Air Water Test**

1. From Utilities menu, select **QA Air Water**.

2. Ensure phantom is set up properly, then press **→**.


4. When prompted, press the **Scan** button on the operator control box. An audible alarm is sounded and the X-ray ON light is illuminated during radiation exposure.

5. Review scout image. The phantom must be centered. Adjust the phantom platform to achieve the proper height.

6. To move the phantom to the right or left, use the **Front/Back** slider control.

   If required, make adjustments, then press **→** to run **→** again. Repeat as required until phantom is properly aligned.

7. When phantom is aligned, select **→** and press **→**.

8. When prompted, press the **Scan** button on the operator control box. An audible alarm is sounded and the X-ray ON light is illuminated during radiation exposure.

   The scanner acquires data and a status indicator shows acquisition and image creation progress. When image processing is complete, image is displayed.

9. Review image to ensure adequate quality. Press **→** to display Complete screen and select option to go Back to Utility.

**QA Air Water Test Evaluation**

**NOTE:** It may take a few minutes for the scan you acquired to be available for viewing. Opening the Patient Data Utility locks the image database (Image Root). If the scan is not displayed in the Patient Data Utility list, close the utility to release the lock, then restart it in a few minutes.

1. At a clinical workstation, start Patient Data Utility. Select the **QA Scans Only** checkbox so that only the QA scans will be displayed in the Name list.

2. Select **QA Air/Water** from the list on the left, then select the most recent Volume scan from the corresponding study list. Output files are listed on the right side of the display.
3. For QA Air Water evaluation, select the output file `QAAW_Results_0` to view the results.

   ![Output Image](image.png)

4. Check the results below each image. Ensure that Air Slice, Water Slice, and Uniformity tests all show PASS. If any test failed, contact Technical Support.

5. If desired, select **Save As** to save a copy of the output image to another location or select **Print** to print the output image. Close image when finished, and close the Patient Data Utility to release the lock.

**QA PAN Test**

**Install PAN Phantom**

1. Prepare the bite tip by inserting the narrow edges of the bite tip down into the bite tip holder uprights. Then turn the bite tip a ¼ turn to lock into place.

2. Insert the phantom platform and bite tip holder into the positioning block. The bite tip should rest on top of the platform.

3. Place PAN phantom on platform with balls facing up and top of arch resting on bite tip.

4. Use the Alignment Lasers to position the phantom. Use the horizontal laser to adjust the height of the phantom as shown below. Use the vertical laser to center the phantom on the platform.
Run QA PAN Test

1. From Utilities menu, select QA PAN.

2. Ensure phantom is set up properly, then press .

3. Select , then press . The scanner initializes.

4. When prompted, press the Scan button on the operator control box. An audible alarm is sounded and the X-ray ON light is illuminated during radiation exposure.

5. Review the scout image. Ensure the phantom is centered. Adjust the phantom platform as needed to achieve the proper height.
   If required, make adjustments, then press . Run again until phantom is properly aligned.

6. When phantom is aligned, select and press . The scanner initializes and moves approximately 1/8 rotation to the Home Position.

7. When prompted, press the Scan button on the operator control box. An audible alarm is sounded and the X-ray ON light is illuminated during radiation exposure.
   The scanner acquires data and a status indicator shows acquisition and image creation progress. When image processing is complete, image is displayed.

QA PAN Test Evaluation

1. Review image. Use brightness and contrast controls as needed to enhance image. All seven metal balls should become visible.

Elongation of the metal balls indicate that the phantom is not in the middle of the focal trough due to poor chair alignment. Ensure PAN phantom is set up properly and repeat test. If a good image cannot be obtained, perform a chair calibration. See Patient Chair Alignment (page 2-5).

2. Press to display Complete screen and select option to exit.

Safety Checks (Optional)

Safety checks must be performed on systems installed in locations that must comply with VDE 0751-1 and/or IEC 62353 standards. Refer to the Service Manual for procedures.
Chapter 5  Complete Installation Forms

Be sure to complete and return the following forms, if applicable:

FDA 2579 - Report of Assembly of a Diagnostic X-ray System
I-6800-56 - i-CAT FLX Installation Checklist
Appendix

A Service Menu Options

Scanner Startup

The scanner and scanner controller are powered independently. Both must be on to function properly and are available for use immediately after startup. No warm up is required.

Power Up

1. Power up the scanner: press the ON button on the operator control box. The POWER indicator on the operator control box and scanner should light.

2. Power up scanner controller and touch screen: press the power button on the front of the scanner controller. The log in screen is displayed.

Log in

Log in to SmartScan STUDIO on the touch screen using the Service account.

1. Enter your user name and password.

2. Press to log into service menu.

<table>
<thead>
<tr>
<th>Option</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acquire</td>
<td>Acquire exam images and access Utilities.</td>
</tr>
<tr>
<td>Exam List</td>
<td>Access utility to add, update, delete and view status of exams.</td>
</tr>
<tr>
<td>Configurator</td>
<td>Access user account management, network information, file maintenance, and export dose logbook and activity logs. Refer to i-CAT FLX Technical Guide</td>
</tr>
<tr>
<td>Remote Assistance</td>
<td>Access website for remote Helpdesk assistance.</td>
</tr>
<tr>
<td>Explorer</td>
<td>Displays Windows® Explorer.</td>
</tr>
<tr>
<td>Control Panels</td>
<td>Displays Windows® Control Panel options.</td>
</tr>
<tr>
<td>Software Update</td>
<td>Initiate a software update.</td>
</tr>
<tr>
<td>Licenses</td>
<td>Copy a license file to the scanner controller.</td>
</tr>
<tr>
<td>Analytic Options</td>
<td>Select options to opt out of analytics mode or software download updates.</td>
</tr>
<tr>
<td>Send Logs</td>
<td>Send system logs to the factory for troubleshooting purposes.</td>
</tr>
<tr>
<td>IEC</td>
<td>Displays command line window for entering IEC commands. Refer to i-CAT FLX Service Manual.</td>
</tr>
<tr>
<td>Vendor Diagnostics</td>
<td>Access utility for vendor diagnostics.</td>
</tr>
</tbody>
</table>
Run Utilities

1. Select Acquire from the menu. Press \[\text{Acquire} \] to access Utilities menu.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PanelCal</td>
<td>Refer to Calibration chapter.</td>
</tr>
<tr>
<td>ShutterCal</td>
<td></td>
</tr>
<tr>
<td>ChairCal</td>
<td></td>
</tr>
<tr>
<td>GeoCal</td>
<td></td>
</tr>
<tr>
<td>QA Line Pair</td>
<td>Refer to QA Tests chapter.</td>
</tr>
<tr>
<td>QA Material</td>
<td></td>
</tr>
<tr>
<td>QA Air Water</td>
<td></td>
</tr>
<tr>
<td>QA Pan</td>
<td></td>
</tr>
<tr>
<td>Reprocess Exam</td>
<td>Refer to i-CAT FLX User Manual.</td>
</tr>
<tr>
<td>Favorites Manager</td>
<td>Refer to i-CAT FLX User Manual.</td>
</tr>
<tr>
<td>Roll-off</td>
<td>Refer to i-CAT FLX Service Manual.</td>
</tr>
</tbody>
</table>

Scanner Shutdown

Log out

1. Press \[\text{Log out} \]. This button is accessible from Scheduled Exams or at the conclusion of the scanning workflow.

2. On the logout confirmation dialog, press \[\text{OK} \] to close exam and log out. The log in screen is displayed.

Power Off

The scanner and scanner controller are powered independently.

1. **Power off scanner**: press the OFF button on the operator control box. The scanner shuts down and the POWER indicators on the operator control box and scanner go OFF.

2. **Power off scanner controller and touch screen**: Press power button on the touch screen to power off both the touch screen and scanner controller. On the shutdown confirmation dialog, press \[\text{OK} \] to shutdown.
Appendix

B Setup of Alternative Network Configurations

The following procedures describe setup needed to support the following alternative network configurations. You may need to work with the site’s IT representative to complete a procedure.

- Remote Image Root Setup for Domain Environment
- Remote Network Share Using Windows Workgroup Environment

Remote Image Root Setup for Domain Environment

Use this procedure to enable access SmartScan STUDIO Integration Services to use a network share.

1. Set Permissions on remote network share

The network share needs to add permission to the Network Service account of the machine running the SmartScan STUDIO Integration Services.

The steps in this section are performed at the computer that will contain the remote Image Root folder.

1. At the remote computer, on the C: drive, create a folder named imageroot.

2. Share the imageroot folder.
   a. Right-click imageroot and select Properties.
   b. Select Sharing tab, then click Advanced Sharing.
   c. Click Share this folder check box.
   d. Click Permissions button, then click Add button on the Permissions window.
e. Click **Object Types** button, then click to check the **Computers** check box. Click **OK**.

f. Enter the domain and machine name of the server running SmartScan STUDIO Integration Services.
   
   **NOTE:** The machine name must end in a dollar sign. Example: gendex\hpaltehughes$

h. Grant full access to the machine account. Select user name, then select **Allow** check box for Full Control, Change, and Read options. Click **OK**.

i. Click **OK** to save the sharing settings.
2. Configure Windows Service Log On
The remaining steps are performed on the SmartScan STUDIO Integration server.
Update the SmartScan STUDIO Integration Services to use the Network Service account for logon so that
the network share can be accessed.

1. Open the Services control panel by pressing the Windows key and R key.
2. Type services.msc and click OK.

3. On the resulting list, double-click one of the three SmartScan STUDIO services to display the Properties window.

4. Click the Log On tab, then select This account button.
5. Enter Network Service in the username field and blank out the two password fields. Click OK. Repeat for all SmartScan STUDIO services.

3. Grant Permission to Change the Registry
Grant the Network Service account permissions to modify the registry:

1. In a command window, run regedit.
2. Navigate to:
   HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Dental Imaging Technologies Corporation\SmartScan STUDIO Integration Services
3. Right-click and select Permissions.
4. Click Add button.
5. Enter **Network Service** in object names field, and click **OK**.

6. Grant full access to the folder. Select **Allow** check box for Full Control and Read options. Click **OK**.

### 4. Local Folder Security Configuration

Grant the Network Service account full control permissions of the following folders:

- C:\ProgramData\Dental Imaging Technologies Corporation\ImportFolder
- C:\ProgramData\Dental Imaging Technologies Corporation\SmartScan STUDIO Importer Service
- C:\ProgramData\Dental Imaging Technologies Corporation\SmartScan STUDIO Update Service
- C:\ProgramData\Dental Imaging Technologies Corporation\SmartScan STUDIO Web Service

1. Navigate to one of the folders above.

2. Right-click the folder and select **Properties**.

3. Select **Security** tab.

4. Click **Edit** button, then click **Add** button.

5. Enter **Network Service** in object names field, and click **OK**.

6. Grant full access to the folder. Select **Allow** check box for Full Control, Change, and Read options. Click **OK**.

7. Repeat for remaining folders.

### 5. Web Service Configuration

Add URL reservations for the Network Service account by running the following netsh commands from a command prompt.

1. Run the command prompt as an administrator.

2. Enter the each of the following commands.

   ```
   netsh http add urlacl url=https://+:8585/VisionRoot user="NT Authority\Network Service"
   netsh http add urlacl url=http://+:8484/VisionRoot user="NT Authority\Network Service"
   ```
3. Use the following command to verify that the reservations exist:

```plaintext
netsh http show urlacl
```

Typical response should include the following entries:

- **Reserved URL**: https://+:8585/VisionRoot/
  - **User**: NT AUTHORITY\NETWORK SERVICE
  - **Listen**: Yes
  - **Delegate**: No
  - **SDDL**: D:(A;;GX;;;NS)

  - **User**: NT AUTHORITY\NETWORK SERVICE
  - **Listen**: Yes
  - **Delegate**: No
  - **SDDL**: D:(A;;GX;;;NS)

4. Close the command prompt window.

6. **Change the Image Root to the Network Share**

Update the image root to the image root server using the SmartScan STUDIO control panel.

1. Start Control Panel and double-click **SmartScan STUDIO Integration Services** control panel.

2. On **Update Service** tab, browse to the remote Image Root directory and select it.
   
   **NOTE**: If prompted, enter credentials for the remote Image Root computer.

3. Click **OK** to apply changes and restart services.

   If the browse folder dialog will not allow access to the network, the properties can be manually updated.

   Use regedit to update the following registry value:

   ```plaintext
   HKEY\SOFTWARE\Wow6432Node\Dental Imaging Technologies Corporation\SmartScan STUDIO Integration Services\Importer\ImageRootDirectory
   ```

   Update the configuration file:

   ```plaintext
   C:\Program Files (x86)\Dental Imaging Technologies Corporation\SmartScan STUDIO Integration Services\ImageRootWeb\vision.config
   ```

   Example contents:

   ```xml
   <?xml version="1.0"?>
   <visionDatastore visionroot="\hpadtehughes\ImageRoot" />
   ```
Remote Network Share Using Windows Workgroup Environment

Use this procedure to enable access to a network shared Image Root folder on a remote network.

1. Configure Remote Network Folder for Storing Image Root Data

The remote Image Root computer is a Windows-based file server that provides a network folder for storing image root data. In order for the network share to be accessible, the following steps must be performed.

The following steps are performed at the computer that will contain the remote Image Root folder.

1. Create a user with a password.
   a. Select **Control Panel** -> ** Administrative Tools** -> **Computer Management**.
   b. Open **Local User and Groups**.
   c. Right-click the Users folder and select **New User**.
   d. Create a user with a password (username = SSSService, password =12345).
   e. Click **Create**.

2. On the **C:** drive, create a folder named **imageroot**.

3. Share the imageroot folder.
   a. Right-click **imageroot** and select **Properties**.
   b. Select **Sharing** tab, then click **Advanced Sharing**.
   c. Click to check the **Share this folder** check box.
   d. Click **Permissions** button, then click **Add** button on the Permissions window.
e. Enter **SSSService** in object name field and click **OK**.

![Image of Select Users, Computers, Service Accounts, or Groups dialog box]

f. Grant full access to SSSService account. Select **Allow** check box for Full Control, Change, and Read options. Click **OK** to close any open windows.

The network share should now be accessible to other computers on the network.

![Image of Permissions dialog box]

2. **SmartScan STUDIO Integration Server**

Create an identical user account on the SmartScan STUDIO Integration server to enable access to the network share created in the above steps.

The following steps are performed on the SmartScan STUDIO Integration server.

1. Follow steps 1a - d from procedure above to create an identical user on the SSS STUDIO Integration server.

2. Add the user to the administrators group.

   **NOTE:** If the site’s IT policy does not allow the use of the administrators group, follow the permissions steps from the *Remote Image Root Setup for Domain Environment* procedure, replacing Network Service with the SSSService account.

   a. Right-click on the user and select **Properties**.
b. On the Member Of tab, click Add.

c. Enter Administrators in object name field, then click OK to close any open windows. The user is now a member of the Administrators group.

3. Update the SmartScan STUDIO Integration Services to use the SSSService account for logon so that the network share can be accessed.

a. Open the Services control panel by pressing the Windows key and R key.

b. Type services.msc, then click OK.

c. On the resulting list, double-click one of the three SmartScan STUDIO services to display the Properties window.

d. Click the Log On tab, then select This account button.

e. Enter the username and password created in step 1, and click OK. Click OK again on the dialog.

f. Repeat for all SmartScan STUDIO services.
4. Update the image root to the image root server using the SmartScan STUDIO control panel.
   a. Start Control Panel and double-click SmartScan STUDIO Integration Services control panel.
   b. On Update Service tab, browse to the remote Image Root directory.
      **NOTE:** If prompted, enter credentials for the remote Image Root computer.
   c. Click **OK** to apply changes and restart services.
Appendix

C Wall Mounting Operator Control Box

The operator control box is configured for desktop usage but can be modified for wall mounting access.

Wall Mount with Cable Exposed

1. Disconnect operator control box cable from rear of overhead panel.

2. At top of operator control box, slide clip away from tab so that tab can be pressed down to loosen side panel (both sides).
3. Lift side panel (tab end) upward and remove from operator control box (both sides).

![Image of side panel being lifted](image)

---

⚠️ **CAUTION**

A ribbon cable is connected from the operator control box face panel to the base. Damage to the ribbon cable may occur if the face panel is separated too far from the base.

---

4. Remove four mounting screws from face panel.

![Image of screws being removed](image)

---

5. Gently lift face panel from base to access ribbon cable.

6. Remove ribbon cable by pressing ribbon connector locking tab (bottom center of connector) and pulling connector out of the socket.

![Image of ribbon cable being removed](image)
7. Rotate face panel 180°.
8. Connect ribbon cable as shown. Ensure that connector is fully seated.

9. Mount face panel with the four mounting screws.

10. There are four outer mounting rings on the operator control box base. These rings can be pre-drilled or punctured with a screw during mounting.

   Position operator control box on wall and mount with wall mounting hardware (four corners).

11. Replace operator control box side panels and re-insert clips under tabs (both sides).
Wall Mount with Cable Inside Wall

1. Disconnect operator control box cable from rear of overhead panel.

2. Remove cable connector cover plate from rear of operator control box.

3. Pull cable out from wire channel.
4. Press the plug locking latch.
5. Disconnect plug from socket. Do not pull on wires. Use a flat blade screwdriver to pry from socket.
6. Protect wires and plug by wrapping them in electrical tape prior to feeding through wall. The plug requires at least a 1” [25mm] diameter hole. The wall hole location should be approximately 1” [25mm] below the top of the operator control box location.

7. Remove the protective tape from plug after feeding through wall. Connect plug to connector. Ensure plug is properly latched.

8. Replace cable connector cover plate. Do not push cable into wire channel.
9. At top of operator control box, slide clip away from tab so that tab can be pressed down to loosen side panel (both sides).

10. Lift side panel (tab end) upward and remove from operator control box (both sides).

11. There are four outer mounting rings on the operator control box base. These rings can be pre-drilled or punctured with a screw during mounting.

12. Position operator control box on wall over hole and mount with wall mounting hardware (four corners).

Replace operator control box side panels and re-insert clips under tabs (both sides).